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Copyright 

Copyright © 1999-2015 Intergraph® Corporation. All Rights Reserved. Intergraph is part of Hexagon. 

Including software, file formats, and audiovisual displays; may be used pursuant to applicable software license agreement; contains 
confidential and proprietary information of Intergraph and/or third parties which is protected by copyright law, trade secret law, and 
international treaty, and may not be provided or otherwise made available without proper authorization from Intergraph Corporation. 

U.S. Government Restricted Rights Legend 

Use, duplication, or disclosure by the government is subject to restrictions as set forth below. For civilian agencies: This was 
developed at private expense and is "restricted computer software" submitted with restricted rights in accordance with 
subparagraphs (a) through (d) of the Commercial Computer Software - Restricted Rights clause at 52.227-19 of the Federal 
Acquisition Regulations ("FAR") and its successors, and is unpublished and all rights are reserved under the copyright laws of the 
United States. For units of the Department of Defense ("DoD"): This is "commercial computer software" as defined at DFARS 
252.227-7014 and the rights of the Government are as specified at DFARS 227.7202-3. 

Unpublished - rights reserved under the copyright laws of the United States. 

Intergraph Corporation 
305 Intergraph Way 
Madison, AL 35758 

Documentation 

Documentation shall mean, whether in electronic or printed form, User's Guides, Installation Guides, Reference Guides, 
Administrator's Guides, Customization Guides, Programmer's Guides, Configuration Guides and Help Guides delivered with a 
particular software product.  

Other Documentation 

Other Documentation shall mean, whether in electronic or printed form and delivered with software or on Intergraph Smart Support, 
SharePoint, or box.net, any documentation related to work processes, workflows, and best practices that is provided by Intergraph 
as guidance for using a software product. 

Terms of Use 

a. Use of a software product and Documentation is subject to the End User License Agreement ("EULA") delivered with the 
software product unless the Licensee has a valid signed license for this software product with Intergraph Corporation. If the 
Licensee has a valid signed license for this software product with Intergraph Corporation, the valid signed license shall take 
precedence and govern the use of this software product and Documentation. Subject to the terms contained within the 
applicable license agreement, Intergraph Corporation gives Licensee permission to print a reasonable number of copies of the 
Documentation as defined in the applicable license agreement and delivered with the software product for Licensee's internal, 
non-commercial use. The Documentation may not be printed for resale or redistribution. 

b. For use of Documentation or Other Documentation where end user does not receive a EULA or does not have a valid license 
agreement with Intergraph, Intergraph grants the Licensee a non-exclusive license to use the Documentation or Other 
Documentation for Licensee’s internal non-commercial use. Intergraph Corporation gives Licensee permission to print a 
reasonable number of copies of Other Documentation for Licensee’s internal, non-commercial.  The Other Documentation may 
not be printed for resale or redistribution. This license contained in this subsection b) may be terminated at any time and for any 
reason by Intergraph Corporation by giving written notice to Licensee. 

 

Disclaimer of Warranties 

Except for any express warranties as may be stated in the EULA or separate license or separate terms and conditions, Intergraph 
Corporation disclaims any and all express or implied warranties including, but not limited to the implied warranties of merchantability 
and fitness for a particular purpose and nothing stated in, or implied by, this document or its contents shall be considered or deemed 
a modification or amendment of such disclaimer. Intergraph believes the information in this publication is accurate as of its 
publication date. 

The information and the software discussed in this document are subject to change without notice and are subject to applicable 
technical product descriptions. Intergraph Corporation is not responsible for any error that may appear in this document. 

The software, Documentation and Other Documentation discussed in this document are furnished under a license and may be used 
or copied only in accordance with the terms of this license. THE USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL 
EVALUATION AS TO THE USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.  

Intergraph is not responsible for the accuracy of delivered data including, but not limited to, catalog, reference and symbol data. 
Users should verify for themselves that the data is accurate and suitable for their project work.  
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Limitation of Damages 

IN NO EVENT WILL INTERGRAPH CORPORATION BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL INCIDENTAL, 
SPECIAL, OR PUNITIVE DAMAGES, INCLUDING BUT NOT LIMITED TO, LOSS OF USE OR PRODUCTION, LOSS OF 
REVENUE OR PROFIT, LOSS OF DATA, OR CLAIMS OF THIRD PARTIES, EVEN IF INTERGRAPH CORPORATION HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

UNDER NO CIRCUMSTANCES SHALL INTERGRAPH CORPORATION’S LIABILITY EXCEED THE AMOUNT THAT 
INTERGRAPH CORPORATION HAS BEEN PAID BY LICENSEE UNDER THIS AGREEMENT AT THE TIME THE CLAIM IS 
MADE. EXCEPT WHERE PROHIBITED BY APPLICABLE LAW, NO CLAIM, REGARDLESS OF FORM, ARISING OUT OF OR IN 
CONNECTION WITH THE SUBJECT MATTER OF THIS DOCUMENT MAY BE BROUGHT BY LICENSEE MORE THAN TWO (2) 
YEARS AFTER THE EVENT GIVING RISE TO THE CAUSE OF ACTION HAS OCCURRED.  

IF UNDER THE LAW RULED APPLICABLE ANY PART OF THIS SECTION IS INVALID, THEN INTERGRAPH LIMITS ITS 
LIABILITY TO THE MAXIMUM EXTENT ALLOWED BY SAID LAW. 

Export Controls 

Intergraph Corporation’s software products and any third-party Software Products obtained from Intergraph Corporation, its 
subsidiaries, or distributors (including any Documentation, Other Documentation or technical data related to these products) are 
subject to the export control laws and regulations of the United States. Diversion contrary to U.S. law is prohibited. These Software 
Products, and the direct product thereof, must not be exported or re-exported, directly or indirectly (including via remote access) 
under the following circumstances:  

a. To Cuba, Iran, North Korea, Sudan, or Syria, or any national of these countries.  

b. To any person or entity listed on any U.S. government denial list, including but not limited to, the U.S. Department of Commerce 
Denied Persons, Entities, and Unverified Lists, http://www.bis.doc.gov/complianceandenforcement/liststocheck.htm, the U.S. 
Department of Treasury Specially Designated Nationals List, http://www.treas.gov/offices/enforcement/ofac/, and the U.S. 
Department of State Debarred List, http://www.pmddtc.state.gov/compliance/debar.html.  

c. To any entity when Licensee knows, or has reason to know, the end use of the Software Product is related to the design, 
development, production, or use of missiles, chemical, biological, or nuclear weapons, or other un-safeguarded or sensitive 
nuclear uses.  

d. To any entity when Licensee knows, or has reason to know, that an illegal reshipment will take place.  

Any questions regarding export or re-export of these Software Products should be addressed to Intergraph Corporation’s Export 
Compliance Department, Huntsville, Alabama 35894, USA. 

Trademarks 

Intergraph, the Intergraph logo, Intergraph Smart, PDS, SmartPlant, SmartMarine, FrameWorks, I-Sketch, IntelliShip, ISOGEN, 
Sapphire, SmartSketch, SPOOLGEN, SupportManager, and SupportModeler are trademarks or registered trademarks of Intergraph 
Corporation or its subsidiaries in the United States and other countries. Microsoft and Windows are registered trademarks of 
Microsoft Corporation. MicroStation is a registered trademark of Bentley Systems, Inc. Other brands and product names are 
trademarks of their respective owners. 
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S E C T I O N  1  

The Intergraph SmartPlant family of process industry solutions is an open line of 
discipline-specific software tools that provide an integrated solution for the entire plant life cycle. 
Knowledge-based, intuitive, easy-to-use, accessible, flexible, and data-driven, SmartPlant 
supports global workflows.  The software enables users to create logical and physical 
definitions of the plant model and enables access to plant data from conceptual design to 
decommissioning. 

SmartPlant is the fulfillment of the Intergraph vision to speed and improve the creation of 
information and to provide this data to multiple users at any moment in the appropriate form.  
Workflows are compressed, reducing production time, lowering costs, enhancing global 
execution, and extending the life and usability of plant information. 

The successor to the Intergraph Plant Design System (PDS), SmartPlant includes expanded 
functionality for front-end engineering and design (FEED), construction, operation, and 
maintenance phases. 
 

Installation Checklist 
For the recommended installation workflow, see the SmartPlant P&ID Installation Checklist: 
SPPIDInstall_Checklist.xlsx. The checklist is located in the same folder as this installation guide. 
 

Introducing SmartPlant P&ID 
SmartPlant P&ID creates intelligent P&IDs by populating the database with relevant plant 
data.  This method provides valuable information throughout the plant life cycle.  As a data-
centric, rule-based solution for the P&ID life cycle, SmartPlant P&ID helps users improve design 
quality, data consistency, and standards compliance.  With quick access to supporting 
engineering data, SmartPlant P&ID significantly cuts design and modification time and increases 
accuracy with its exclusive data-centric approach and use of design rules, automatic checks, 
and drag-and-drop capabilities. 

SmartPlant P&ID is vastly different from graphic-driven P&ID solutions of today.  All data from 
the P&ID is stored in the plant database and adheres to plant standards.  The graphical 
representation of the P&ID is a view or a report of the data.  The strong data import and export 
facilities of SmartPlant P&ID allow users to populate the system with relevant plant data, such 
as process data from process simulation databases based on Aspen Basic Engineering from 
Aspen Technologies, Inc. or equipment and line lists.  You can then use this information in the 
SmartPlant P&ID Stockpile to design the P&ID. 

The rule-based and automation capabilities of SmartPlant P&ID also differentiate it from other 
P&ID systems.  SmartPlant P&ID features a comprehensive, user-definable rule-based system 
that assists the engineer during the design phase of the plant and subsequent life cycle 
phases.  Data is entered directly into the database; rules are executed; and feedback is 
immediate.  The design rule-base confirms data consistency and compliance with plant and 
engineering standards, allowing faster, more efficient design with less iteration. 

Welcome to SmartPlant 



Welcome to SmartPlant 
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SmartPlant P&ID incorporates the latest Microsoft technologies, such as OLE automation, to 
provide integration with existing data and other systems.  Running on various Microsoft 
Windows operating system platforms, SmartPlant P&ID does not require a traditional, expensive 
CAD engine for the creation of P&IDs. The open architecture of SmartPlant P&ID permits 
integration with other systems, such as Intergraph PDS, SmartPlant Instrumentation, and Aspen 
Basic Engineering, all of which allow users to share data with third-party software. 
 

SmartPlant P&ID Program Group 

SmartPlant P&ID provides multiple views of a central, unified data structure that represents the 
plant model.  A view is a visual presentation of the data in the plant model and can be a 
schematic drawing or a table.  The plant model is the computer representation of the conceptual 
design, including all plant components and their relationships.  By manipulating model views, 
you can organize the information within the plant model to better understand and maintain the 
data. 

SmartPlant P&ID has several programs and utilities for running and managing your plant data. 

 SmartPlant P&ID provides the design environment for 
SmartPlant P&ID drawings. 

 SmartPlant P&ID Engineering allows you to edit your 
data while disallowing graphical changes. 

 SmartPlant P&ID Drawing Manager allows you to create 
and delete drawings, manage drawing versions, and print 
multiple drawings. Drawing Manager also allows you to 
perform Workshare and project-specific commands. 

 SmartPlant P&ID Insulation Specification Manager 
allows you to create and modify lookup tables for 
insulation specifications and thicknesses. 

 SmartPlant P&ID Options Manager defines plant-wide 
graphic standards for symbology, gapping, heat tracing, 
and formats.  Options Manager also defines paths to 
SmartPlant P&ID files and directories. 

 SmartPlant P&ID Rule Manager defines rules for 
placement and property copying on placement. 
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S E C T I O N  2  

Supporting internationalization in a homogeneous environment is one of the enhancements 
available in SmartPlant Enterprise. A homogeneous environment uses elements from only a 
single locale. For example, a German customer running on a German operating system using 
only German characters and German cultural conventions is a fully supported homogeneous 
environment configuration. 

Homogeneous Environments 

When starting a new project, use extra care during installation and configuration to ensure the 
proper creation and maintenance of homogeneous environments: 

 All the computers (servers and clients) within an integrated SmartPlant Enterprise 
implementation must have the same regional settings, and no one should change the 
regional settings after the project has started. 

 Do not cross the decimal locale boundary. This is the most common cause of numeric data 
corruption and calculation errors. Having users with different regional settings (like with a 
period versus a comma for the decimal point) causes the software to interpret values 
unpredictably. For example, a pipe run with a pressure of 35.3 psi can be read by the 
software as 353 psi to the user with different regional settings. A cable length defined as 39 
ft 11,21 inches has been interpreted as 121718910971323 meters when published to an 
XML file. These incorrect interpretations may be used in internal software calculations and 
can be impossible to backtrack or correct. Do not change the decimal point character to try 
to solve an issue. Doing so will only corrupt values in the database or in text files. 

 Do not cross the character-set locale boundary. For example, the character set boundary 
between Western (Latin-based) and Eastern Europe (Cyrillic-based), or between Eastern 
Europe and Japan. 

 Create Oracle databases using AL32UTF8 for the database character set and AL16UTF16 
for the NLS character set. 

 Never modify the NLS_LANG registry entry on an Oracle client. Doing so causes the 
character data not to convert to Unicode. 

 Create Microsoft SQL Server databases with locale-specific collation settings and ensure 
that all databases have the same setting. 

Heterogeneous Environments 

In contrast, a heterogeneous environment using elements from different, or even multiple 
locales, is not supported. Many customers are currently operating in unsupported 
heterogeneous environments and are often not aware of that fact. Examples of heterogeneous 
environments: 

 Entering or viewing Japanese data on an US/English operating system 

 Using German Regional Settings (where the decimal point is a comma) on a US/English 
operating system 

Internationalization 



Internationalization 
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 Using databases with different character encodings such as CL8MSWIN1251 or JA16SJIS 

 Using multiple languages in a project, especially when crossing language-group boundaries 

 Using an English server with different local language clients 

International / Bi-lingual Projects 

International bi-lingual projects are possible; however, great care must be used when 
configuring these environments. Limitations exist and must be properly understood: 

 Oracle and MS SQL Server databases can reside on any language operating system, as 
long as the databases have been created and configured with proper Unicode and collation 
settings. 

 All SQL Server databases must have the same collation setting and reflect the “master” 
language. Text is stored, sorted, indexed, and presented based on the collation setting. You 
must determine which language will be used primarily to generate output (P&IDs, SLDs, 
reports, approval documents, and so forth.) If Russian and English text is entered, and 
Russian is the target locale, the chosen collation should be based on the Cyrillic character 
set. 

 All Microsoft operating systems (Japanese, Russian, German, and so forth) can enter 
English characters. The reverse, however, is not true in most cases. 

 Keyboard-locale can be changed as long as a character-set and code-page boundary is not 
crossed. For example, English, German, French, and Spanish characters can all be used in 
the same project because the same Windows® code-page (1252) is used. However, Russian 
characters (code-page 1251) cannot be used in a US/English environment. 

 You must decide which language operating system will be the master for bi- lingual projects. 

The following is an example of a Russian-based project: 

Companies in the United States and the United Kingdom are working a project with a Russian 
company and the deliverables (drawings, reports, and so forth) must ultimately be provided in 
Russian. The companies in the U.S. and the U.K. are working the project using the "master" 
Russian operating systems (possibly using virtual Russian operating systems running on 
VMware Workstation). The U.S. and U.K. companies can install and use English Microsoft 
Office products on the Russian operating system because Office products are globally enabled. 
If a Russian interface exists for the SmartPlant Enterprise application, then Russian users can 
use the Russian interface while the English-speaking users would continue to use the 
US/English interface. English-speaking engineers can enter English characters. Russian-
speaking engineers can enter Russian characters. 

However, because the Russian locale uses different decimal and character-set locales, 
everyone (English and Russian engineers) must use the Russian decimal symbol which is a 
comma. For customization purposes, databases can be modified to accommodate new Russian-
specific requirements (fields, properties, and so forth.) Using filters, display sets, and other 
software features, bi-lingual projects can be further customized. Graphic data, reports, and so 
forth can be created in either or both languages. 

 Do not change regional settings to reflect a U.S. environment in order to resolve 
problems in a non-US/English homogeneous configuration. Doing this creates a heterogeneous 
configuration that will cause other possibly hidden problems that cannot be corrected. Everyone 
working on a project must use the same regional settings and character set throughout the life of 
the project. 



 Internationalization 
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Citrix XenApp Solutions for International Projects 

Using Citrix XenApp Solutions, you can define environments that isolate users from having to 
interact with non-native language operating systems while improving data integrity and 
minimizing opportunities for data corruption. However, users still have to enter data using 
master locale conventions for the project (decimal separator and date conventions, for 
example). You can create these environments using different combinations of languages, but 
some limitations exist. For example, you cannot use Russian and Chinese text together in a 
project. In addition, special language characters (the German ä and ß for example) cannot be 
used if the master locale is outside the western Latin-based languages (the master locale is 
Russian, Chinese, Japanese, or Korean for example). 

Questions and Assistance 

Please contact your support representative for assistance and answers to your questions: see 
Intergraph Customer Support (http://support.intergraph.com/). 

 
  

http://support.intergraph.com/
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S E C T I O N  3  

Before beginning an installation of the SmartPlant software, verify that your servers meet the 
requirements in this section. 

 We recommend that you do not install the SmartPlant software on the database server. 
 

SmartPlant P&ID Database Server 

Hardware Recommendations 

SmartPlant P&ID testing is done on computers having a 2.4 GHz processor and 4 GB of RAM. 
For additional details regarding platform support, please review the latest compatibility matrix 
available on Intergraph SmartSupport (http://smartsupport.intergraph.com). If you cannot access 
the compatibility matrix, contact Intergraph Support (http://support.intergraph.com/). 

Supported Operating Systems 

 Microsoft Windows Standard Server 2008 R2 Service Pack 1, 64-bit 

 Microsoft Windows Enterprise Server 2008 R2 Service Pack 1, 64-bit 

Supported Database Servers 

 Microsoft SQL Server 2012 R1 

 Oracle Database 11g Release 2 (11.2.0.4), 64-bit (Standard or Enterprise) 
 

Hardware and Software 
Recommendations 

http://smartsupport.intergraph.com/
http://support.intergraph.com/


Hardware and Software Recommendations 
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SmartPlant P&ID Workstation 

Hardware Recommendations 

SmartPlant P&ID testing is done on computers having a 2.4 GHz processor and 4 GB of RAM. 
For additional details regarding platform support, please review the latest compatibility matrix 
available on Intergraph SmartSupport (http://smartsupport.intergraph.com). If you cannot access 
the compatibility matrix, contact Intergraph Support (http://support.intergraph.com/). 

Recommended Disk Space 

 Oracle 32-bit Client: 1.0 GB 

 Full installation of SmartPlant P&ID: 0.3 GB 

 Additional disk space is required for software prerequisites and optional software that you 
install. 

Supported Operating Systems 

 Microsoft Windows 7 Professional and Enterprise Service Pack 1, 64-bit 

 SmartPlant P&ID is certified on Windows 7 with UAC ‘On’ at Level 3 (Default) 

Supported Database Clients 

 Oracle 11g Client Release 2 (11.2.0.4), 32-bit 

 

 Microsoft .Net Framework 4.0 (installed with SmartPlant P&ID) must be installed before 
installing Oracle 11g 32-bit Client. 

 The client database software must be of the same version as the server database software. 

 Oracle 32-bit Client is required for both 32-bit and 64-bit Oracle databases. 

 Do not use Oracle 'light client' as it does not include some of the required .dll files. 

 For SQL Server, no client installation is required. 

Software Prerequisites 

 Microsoft .Net Framework 4.0 and 4.5 

 SmartPlant License Manager (SPLM) 2010 Client (11.00) or 2012 Client (12.00). The 
licensing is delivered on its own CD that comes with your SmartPlant P&ID product DVD. 

 Microsoft Internet Explorer 9, 10, or 11, 64-bit (required for viewing the Readme file, the 
report generated from Rule Manager, and the Online documentation delivered with the 
software) 

 Microsoft XML Core Services (MSXML) 6.0 Service Pack 1 or 6.0 Service Pack 3 

http://smartsupport.intergraph.com/
http://support.intergraph.com/


 Hardware and Software Recommendations 

 

 

SmartPlant P&ID Installation and Upgrade Guide 15 
 

Optional Software 

 Apart from SmartSketch, SmartPlant Engineering Manager, and Intergraph Smart 3D 
SP3DPIDClient, the following software programs are not Intergraph corporation software and 
are owned by third parties.  It is the responsibility of the customer to select at its sole discretion 
the applicable third party software the customer desires to use to generate reports and 
Intergraph makes no recommendation as to the choice of said third party software.  The 
customer is responsible for obtaining a valid license to use said third party software from the 
owner of said third party software and to pay any license fees to the owner of said third party 
software for the use of said third party software.  INTERGRAPH DISCLAIMS AND MAKES NO 
WARRANTY EITHER EXPRESS OR IMPLIED, INCLUDING THE WARRANTIES OF 
MERCHANTABILITY OR THE WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE 
IN REGARDS TO SAID THIRD PARTY SOFTWARE. 

 For administrative functions, SmartPlant Engineering Manager 2014 R1 

 PDF reader (for viewing the printable guides and for displaying the license agreement when 
installing Intergraph Smart 3D SP3DPIDClient) 

 Microsoft Excel from Office 2007 Service Pack 2, with Hot Fix package, Office 2010 Service 
Pack 1 or 2 (32-bit only), or Office 2013 Service Pack 1 (32-bit only). (Microsoft Excel is 
required for working with report templates, importing and generating reports, importing from 
SmartSketch, saving drawings as MicroStation or AutoCAD, and for viewing the Installation 
Checklist and various other files.) 

 Intergraph Smart 3D SP3DPIDClient 2014 R1 (10.01.15.0060) for use with Smart 3D 2014 
or 2014 R1. This software is required for using SmartPlant 3D specifications in the 
SmartPlant P&ID Piping Specification Utility and is available on the SmartPlant P&ID product 
DVD. 

 For working in a thin client environment, Citrix XenApp 6.5 or Citrix XenDesktop 7.0 RDS on 
Windows Server 2008 R2 Service Pack 1, 64-bit (Standard or Enterprise) 

 One of the following drawing software programs (for compatibility with the 'Save As' feature): 

 SmartSketch 2014 or 2014 R1 

 Autodesk AutoCAD 2012 

 Bentley MicroStation V8 
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S E C T I O N  4  

Before you begin installing the software, verify that the computers on which the software 
components will be installed meet the requirements described in the Hardware and Software 
Recommendations (on page 13). 
 

Loading SmartPlant P&ID Prerequisite Software 
Install any required prerequisite software which is not yet installed on your computer.  The 
following software is required: 

 SmartPlant License Manager. 

 Microsoft .Net Framework. If working on an Oracle platform, you must install .Net Framework 
4.0 before installing Oracle client. For details, see Installing Oracle Client > Prerequisites (on 
page 20). 

 In order to use the Piping Specification Utility with SmartPlant 3D, you must install the 
Intergraph Smart 3D SP3DPIDClient. For details, see Install Intergraph Smart 3D 
SP3DPIDClient (on page 23). 

 

 Requirements may vary depending on your particular configuration. 

 If .Net Framework is not installed or if .Net 4.0 client profile is installed, the software prompts 
you to install Microsoft .Net Framework 4.5; after installation, the Welcome page of the 
setup appears. If .Net 4.0 Extended (FULL) is installed, the SmartPlant P&ID installation 
installs Microsoft .Net Framework 4.5 as part of the software setup. 

 For details of the specific software versions that are compatible with your product and 
working environment, see SmartPlant P&ID Workstation (on page 14). 

 

Using Environment Variables for Tracking Licensing 
If you are using SmartPlant License Manager 2010, SmartPlant License Manager 2012, or a 
later version, an administrator can create environment variables to customize license tracking. 
These variables match the columns in the SmartPlant License Manager logging file (or journal 
report).  The variable name must exactly match the column name. 

The environment variables can be added and changed using automated scripts, custom product 
launching utilities, or manually (as shown in the below example). The environment variables can 
be defined at the system level or user level.  If the environment variable(s) is added at both the 
system and user levels, the user level will take precedence over variable(s) added at the System 
level. 

Any of the following variables can be defined as needed. 

ProjectName - Defines the project name. There is a maximum of 50 characters. 

NodeName - Defines the node name. There is a maximum of 30 characters. 

Before You Install 
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UserNameEx - Defines the user name. There is a maximum of 50 characters. 

 Please contact your support representative if you need assistance. 

 
 

Add an Environment Variable 

The following steps are an example of how to manually add new environment variables. 

1. Open Control Panel. 

2. Click System Properties and select the Advanced tab. 

3. Click Environment Variables.... 

4. Click New User Variable.  Define the new variable name and value. 

 

5. Click OK to add the variable. 
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For SmartPlant P&ID, Oracle client installation only is required. You install Oracle client after the 
Oracle database server installation has been completed. For details of Oracle server installation, 
refer to the SmartPlant Engineering Manager Installation and Upgrade Guide. 

Oracle Instances 

If one server hosts the databases of several products, Intergraph recommends that each 
product's database be a separate instance, each of which can host multiple plants. 

The advantage of placing each product's database in its own instance is that only the affected 
application will be off-line during backup, performance tuning, and other database maintenance 
activities. Additionally, global tuning parameters that apply to one instance can be tailored to the 
specific product requirements. 

According to Oracle documentation, the only limit to the number of instances you can have on 
any machine is the availability of resources. However, the number of instances on one database 
server should be minimized, because each additional instance places additional load on the 
server. 

Each instance adds redundant tablespaces, rollback segments, background processes, and 
memory requirements for each SGA (System Global Area). For this reason, you should start by 
putting the database of one product for several plants into a single instance. Then, when the 
number of plants increases, or a plant becomes very large, consider separating the database 
into new instances, adding server memory, or even adding database servers. 
 

Installing Oracle Client 
The Oracle client provides SmartPlant P&ID with the means to interface with the Oracle 
database server.  You can install the Oracle client either on a file server or on the local 
station.  If you install the Oracle client on a station, make sure you have the appropriate access 
rights to the Oracle database server. 

After the Oracle client installation process is complete, you proceed by installing SmartPlant 
P&ID.  Before you start the installation process, make sure that the machine (file server or local 
station) has access to a CD-ROM or DVD drive.  If your machine does not have access to a 
suitable drive, you need to copy all the installation files from the installation media to your local 
hard disk. 
 

Oracle Installation and Configuration 
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Prerequisites 

 Make sure that a compatible Oracle server version is installed. 

 Set up your client Windows regional and language options as you require.  You can only set 
up these options before the client installation.  If you want to change the regional and 
language options after the installation, you will have to reinstall the Oracle client for the 
changes to take effect. 

 For the current version of SmartPlant P&ID, Microsoft .Net Framework 4.0 must be installed 
before installing Oracle client. If Oracle client was installed before .Net Framework, you may 
see the following message when opening Drawing Manager: 

 

To fix the problem, do the following: 

1. Uninstall Oracle client. 

2. Install Microsoft .Net Framework 4.0 (delivered on the SmartPlant P&ID DVD layout). 

3. Install Oracle client.  
 

Install Oracle Client 

 Before installing Oracle Client, ensure that you have met the conditions specified 
under Prerequisites. 

1. Start the Oracle Universal Installer.  

2. On the Select Installation Type page, from the list, select one of the following: 

 Administrator — For users who need Administrator functions, such as the ability to 
create tablespaces. 

 Runtime — For all other users. 

3. Click Next. 

4. On the Download Software Updates page, select Skip software updates and click Next. 

5. On the Select Product Languages page, select English and click Next. 

6. On the Specify Installation Location page, click the Browse button next to the Oracle 
Base field and locate where you want to install the software. 

 The Software Location field is updated according to the information in the Oracle 
Base field. if you want to change this location use the Browse button to navigate to the 
required location. 

7. Click Next. 
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8. On the Perform Prerequisite Checks page, click Next. 

9. On the Summary page, click Install. 

10. On the Finish page, on completion of the installation, click Close. 

11. Restart the client machine. 

12. Create an alias to the Oracle database on the client machine using Oracle Net Manager. 

 The alias name can contain any alphanumeric characters without spaces. 

13. Install the appropriate Oracle client patch. 

 After installation, you must not change any of the default values of the NLS_LANG 
parameter on the client. 
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This section describes how to install SmartPlant P&ID and supporting software.  Before you 
begin installing the software, verify that the computers on which the software components will be 
installed meet the requirements described in the Hardware and Software Recommendations (on 
page 13). 

The Open Database functionality, incorporated into all parts of the SmartPlant software, allows 
you to install pieces of the software on several different workstations.  You do not have to 
maintain a server for just SmartPlant Engineering Manager.  For example, you can install 
SmartPlant Engineering Manager and its related managers on one workstation, SmartPlant 
P&ID and its related managers on a different workstation, and the reference data on yet another 
workstation or file server. 

 During installation of the software, you have the option of installing the fully functional 
SmartPlant P&ID or SmartPlant P&ID Engineering, which allows data editing, but does not allow 
placement, moving, or deleting items on the drawing sheet. 

 
 

Install Intergraph Smart 3D SP3DPIDClient 
In order to use the Piping Specification Utility with Smart 3D, you must install the Intergraph 
Smart 3D SP3DPIDClient. 

 Before installing Intergraph Smart 3D SP3DPIDClient, you must uninstall any 
previous installation of SmartPlant 3D Piping Specification Remote Access Client. 

1. Insert the SmartPlant P&ID DVD into the drive. If the installation does not start 
automatically, double-click setup.exe in the main folder. 

2. On the Welcome page, click the Additional Software link. 

3. On the Additional Software page, click Intergraph Smart 3D SP3DPIDClient. 

4. In the wizard that opens, on the Welcome page, click Next. 

5. On the Software License Agreement page, select your country from the list. 

6. Click Display to view and read the license agreement.  You must have a PDF reader 
installed to be able to view the Software License Agreement. 

7. Close the Software License Agreement window, and then click Yes to accept the license 
agreement. 

8. On the Destination Folder page, accept the default installation path or if desired, specify a 
different path, and then click Next. 

9. On the Ready to Install Intergraph Smart 3D SP3DPIDClient page, click Install. 

10. On completion of the installation, click Finish to close the installation wizard. 

Installing the Software 
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Grant Permissions to Write to a Registry Key 
During the installation process, you may receive an error stating that setup does not have 
permission to modify one or more registry keys.  This procedure explains how to grant write 
permissions to the registry keys. 

1. Click Start > Run.  

2. Type regedit.exe, and click OK. 

3. In the left window, do one of the following: 

 For a 32-bit machine, select the 
HKEY_LOCAL_MACHINE\Software\Intergraph\Applications registry key. 

 For a 64-bit machine, select the 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Intergraph\Applications 
registry key. 

4. Right-click and on the shortcut menu, click Permissions. 

5. On the Permissions for Applications dialog box, click Advanced. 

6. At the bottom of the Advanced Security Settings for Applications dialog box, clear the 
option: Include inheritable permissions from this object's parent. 

7. On the security dialog box that appears to verify your change, click Remove. 

8. Reselect the Include inheritable permissions from this object's parent check box. 

9. Select the Replace all child object permissions with inheritable permissions from this 
object check box. 

 

Uninstall a Previous Version of SmartPlant P&ID 
1. From the Windows Control Panel, select Programs and Features > Uninstall a Program. 

2. Select Intergraph SmartPlant P&ID and then click Uninstall. 

 To uninstall a previous Service Pack, select the appropriate row in the list of installed 
programs. 

3. At the message prompt to confirm removal of the software, click Yes. 

4. On the Maintenance Complete page, click Finish. 
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Install SmartPlant P&ID 

 

 SmartPlant License Manager software is required for concurrent licensing for both the core 
SmartPlant P&ID product and for each feature, therefore you must install and configure 
SmartPlant License Manager on your workstation before installing SmartPlant P&ID.  This 
licensing software is delivered on its own media.  For more information about using and 
configuring concurrent licensing, refer to the SmartPlant License Manager Online Help. 

 If you previously uninstalled a SmartPlant P&ID 2009 SPx Hot Fix, before installing the 
current version of SmartPlant P&ID, you must first run the CleanUp Utility. To download and 
run this utility, go to the URL for Intergraph Smart Support 
(http://smartsupport.intergraph.com), then under Find the answer to your question type 
20488 and follow the instructions. 

1. Insert the SmartPlant P&ID DVD into the drive. If the installation does not start 
automatically, double-click setup.exe in the main folder. 

2. On the Welcome page, click the Additional Software link if you want to perform any of the 
following installations: 

 Install SmartPlant P&ID Reference Data (on page 33) 

 Install Intergraph Smart 3D SP3DPIDClient (on page 23) 

 Install SmartPlant Engineering Manager (for details, see SmartPlant Engineering 
Manager Installation and Upgrade Guide) 

 After installing additional software and closing the setup, to continue with the 
installation of SmartPlant P&ID, on the Additional Software page, click Back. 

3. To install SmartPlant P&ID, click Start Setup. 

4. On the Details and Features page, enter your user name and company details. 

 

 By default, the user name and company name are obtained from the Registry. You may 
change the values, but you may not leave these fields blank. 

 For an evaluation copy of the software, these fields are mandatory. 

5. Enter your product serial number. 

6. Under Select Installation Mode, choose whether to install SmartPlant P&ID or SmartPlant 
P&ID Engineering. 

7. Under Select Features to Install, select any additional features that you want to install. 

 Drawing Manager is always installed, together with SmartPlant P&ID or SmartPlant 
P&ID Engineering, regardless of any other features you select. 

8. In the Install Path field, accept the default installation path or if desired, specify a different 
path, and then click Next. 

9. On the License Agreement page, select your country or region from the list to view the 
license agreement in your language and then select the I agree to the license agreement 
and conditions check box. 

10. Click Install. 

http://smartsupport.intergraph.com/
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11. On completion of the installation, if you want to open the Readme file, select View Readme. 

12. Click Finish to close the installation wizard. 

 

 If you try to install SmartPlant P&ID software when you do not have write permissions to the 
registry on the computer on which you are installing, a warning message appears. For 
details of what to do if you see this message, see Grant Permissions to Write to a Registry 
Key (on page 24). 

 The driver used for printing the PDF files, SmartPlant PDF Converter (Amyuni 4.5), is 
included in the SmartPlant P&ID installation. This printer is used for PDF generation and 
should not be removed or used for any other purpose.  If you are unable to generate PDF 
files because this driver is missing, restore the driver by running the executable file 
InstallPDFConverter.exe, which is installed by default in the software installation folder path 
..\SmartPlant\P&ID Workstation\bin. 

 

Modify or Uninstall the Latest Version of SmartPlant 
P&ID 

1. In the Windows Control Panel, navigate to the Programs and Features window. 

2. From the list of installed programs, select Intergraph SmartPlant P&ID 2014 R1 and then 
click Change. 

3. On the page that appears, click Modify. 

4. On the Modify / Uninstall page, select one of the following options: 

 Add or Remove Features 

 Repair 

 Uninstall 

5. Click Next. 

 If you selected Repair or Uninstall, a wizard page opens with progress bars for the 
overall process and individual details. 

6. If you selected Add or Remove Features, under Select Features to Add or Remove, do 
the following: 

a. Select the check boxes beside those features that you want to add. 

b. Clear the check boxes beside those features that you want to remove. 

c. Click Update. 

 The Add or Remove Features option only adds or removes the additional features; 
it does not remove Drawing Manager or SmartPlant P&ID / SmartPlant P&ID Engineering. 

7. On completion of the process, click Finish. 
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Installing SmartPlant P&ID in Silent Mode 
Silent mode installation involves running a command at the command prompt with arguments 
specifying the license activation, product serial number, and installation path. In addition, you 
can specify which individual software features to install and the path of the log file. 

 

 Because SmartPlant P&ID installation requires SmartPlant License Manager for concurrent 
licensing, you must first install the SmartPlant License Manager software on your 
workstation and on every other workstation where you are going to install SmartPlant P&ID 
in silent mode.  For more information about installing and configuring SmartPlant License 
Manager, see the SmartPlant License Manager Online Help. 

 You must ensure that there is sufficient disk space on each workstation for the installation. 

 Prior to creating a silent setup of SmartPlant P&ID over a network, ensure that the following 
conditions exist: 

 For a new release, all previous existing versions of SmartPlant P&ID on the target 
machine have been uninstalled prior to network installation. 

 The target machine does not have a directory by the same name to which SmartPlant 
P&ID is to be installed. 

 The target machine meets the free disk space recommendations specified in SmartPlant 
P&ID Workstation (on page 14). 

 All applications are closed. 
 

Install SmartPlant P&ID in Silent Mode 

 At each workstation on which you want to install the software, open a Command Prompt 
window and type the silent installation command according to the following syntax: 

"<setup source folder path>\setup.exe" /install /silent 

InstallFolder="<path>" /log "<log file path and name>.log" 

SLAACCEPT="YES" SERIALNUM="<product serial number>" ADDLOCAL="ALL" 

 

 Ensure that the command line includes spaces where shown before and after 
arguments. 

 

 Double quotes are required only if the path to the setup.exe file contains spaces. 

 Argument values are case sensitive. 

 Mandatory arguments are validated by the setup procedure. If an argument or option is 
missing, the setup stops and a log is produced with the name of the missing argument. 

Example command line for SmartPlant P&ID installation: 

"\\SPPIDInstall\Setup Files\Setup.exe" /install /silent 

InstallFolder="C:\Program Files (x86)\SmartPlant" /log" 

C:\Setup.log" SLAACCEPT="YES" SERIALNUM="012345678" ADDLOCAL="ALL" 

Pause 
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Example command line for SmartPlant P&ID Engineering installation: 

"\\SPPIDInstall\Setup Files\Setup.exe" /install /silent 

InstallFolder="C:\Program Files (x86)\SmartPlant" /log" 

C:\Setup.log" SLAACCEPT="YES" SERIALNUM="012345678" PIDMODE="1" 

ADDLOCAL="ALL" 

Pause 

Command Line Arguments 

Argument Description Mandatory Notes 

<setup source 
folder path> 

The path to the file that 
launches the setup 

Yes  

setup.exe The name of the file that 
launches the setup 

Yes  

-install Install product No  

-uninstall Uninstall product No  

-repair Repair product No  

-modify Modify product features No  

-s, -silent Silent mode Yes This argument is required for 
silent mode installation, together 
with the mandatory custom 
command line arguments; 
otherwise, the installation user 
interface is displayed. 

-l, -log Specifies a log file No If the log argument is used, a 
valid file path and name must be 
specified. 

InstallFolder Specifies the installation 
folder 

No The default installation folder 
should be set in bundle.wxs. If no 
value is specified, the default 
installation folder path is: 
"C:\Program Files 
(x86)\SmartPlant\". 

SLAACCEPT Approve license 
agreement 

Yes Accepted value: YES 

SERIALNUM Sets the serial number to 
be used for installation 

Yes A valid serial number 
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Argument Description Mandatory Notes 

USERNAME Sets the user name See 'Notes' This argument is mandatory for 
an Evaluation Mode installation 

COMPANYNAME Sets the company name See 'Notes' This argument is mandatory for 
an Evaluation Mode installation 

PIDMODE Determines the installation 
mode (installs SmartPlant 
P&ID or SmartPlant P&ID 
Engineering) 

No Accepted values: 

 0 — Installs SmartPlant P&ID 
(this is the default if no 
argument is specified) 

 1 — Installs SmartPlant P&ID 
Engineering 

ADDLOCAL The value of the 
ADDLOCAL argument is a 
list of features that are to 
be installed locally. If the 
ADDLOCAL argument is 
not present in the 
command line, the 
software installs features 
according to the default 
settings (for details, see 
the Notes below). 

No For use with the /install and 
/modify arguments. 

Accepted values: 

 ALL — installs all available 
features 

 Specified list of features 
delimited by commas.  The 
features must be present in 
the Feature column of the 
Feature table. The features 
available for this product are 
listed in the Notes below. 

REMOVE The value of the REMOVE 
argument is a list of 
features that are to be 
removed or excluded when 
modifying an installation. 

No For use with the /modify 
argument. 

Accepted values: 

 ALL — removes or excludes 
from the installation all 
features, including the main 
application 

 Specified list of features 
delimited by commas.  The 
features must be present in 
the Feature column of the 
Feature table. The features 
available for this product are 
listed in the Notes below. 
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 Command line arguments and their values are case-sensitive; therefore you must ensure 
that they are typed exactly as shown in the above table. 

 Each command line argument must be preceded by a '-' or '/' delimiter, for example: -

install - silent or /install / silent 

 If none of the arguments: install, uninstall, repair, or update is specified, install is 
assumed as the default. 

 Drawing Manager and either SmartPlant P&ID or SmartPlant P&ID Engineering are always 
installed. You can use the following ADDLOCAL / REMOVE arguments (case-sensitive) for 
installing or removing specific features: 

Feature Argument Value Notes 

SmartPlant P&ID / 
SmartPlant P&ID 
Engineering and Drawing 
Manager 

SPPID These features are always installed 
regardless of whether this argument is 
specified for ADDLOCAL. To install 
these features alone, use the syntax 
ADDLOCAL = "SPPID". 

When using the syntax REMOVE = 
"SPPID", all software features are 
uninstalled. 

Options Manager OPTIONSMGR This feature is not installed by default if 
ADDLOCAL is not present in the 
command line 

Insulation Specifications 
Manager 

INSULATIONMGR This feature is not installed by default if 
ADDLOCAL is not present in the 
command line 

Rule Manager RULEMGR This feature is not installed by default if 
ADDLOCAL is not present in the 
command line 

To install specific features, use the syntax: ADDLOCAL="FEATURE1,FEATURE2", for 

example: ADDLOCAL="OPTIONSMGR,RULEMGR".  To skip or remove specific features, use 

the syntax: REMOVE="FEATURE1,FEATURE2", for example: REMOVE="INSULATIONMGR".  

 When including the /modify argument, if a feature is not included in the ADDLOCAL or 
REMOVE arguments, that feature remains unmodified; if it was not initially installed, it will 
not be subsequently added, and if it was initially installed, it will not be removed. 

 After a successful installation, you may be required to restart the computer. 

 If a mandatory parameter or value is missing or the value is incorrect, the installation will 
stop and an error will be recorded in the log file. It is recommended that after installation, you 
check the .log file to ensure that the installation proceeded without errors. If the silent 
installation was successful, at the end of the .log file, the following string appears: 

Exit code: 0x0 
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Silent Mode Installation Example Scripts 

 

 These examples show the use of either '/' or '-' as argument delimiters. 

 The 'Pause' command is optional and is used to display completion of the process in the 
Command Prompt window. 

 A value of '%tmp%' for the log file path can be used to write the log file to the active user's 
local 'Temp' folder. 

Install All Features 

"\\SmartPlant P&ID\Setup Files\Setup.exe" /install /silent 

InstallFolder="C:\Program Files (x86)\SmartPlant" /log "C:\Install.log" 

SLAACCEPT="YES" SERIALNUM="012345678" PIDMODE="0" ADDLOCAL="ALL" 

Pause 

Install SmartPlant P&ID Engineering Mode with All Features 

"\\SmartPlant P&ID\Setup Files\Setup.exe" /install /silent 

InstallFolder="C:\Program Files (x86)\SmartPlant" /log "C:\Install.log" 

SLAACCEPT="YES" SERIALNUM="012345678" PIDMODE="1" ADDLOCAL="ALL" 

Pause 

Install Specific Features 

"\\SmartPlant P&ID\Setup Files\Setup.exe" -install -silent 

InstallFolder="C:\Program Files (x86)\SmartPlant" -log "%tmp%\Install 

Part.log" SLAACCEPT="YES" SERIALNUM="012345678" 

ADDLOCAL="OPTIONSMGR,RULEMGR" 

Pause 

Uninstall the Product 

"\\SmartPlant P&ID\Setup Files\Setup.exe" -uninstall -silent -log 

"C:\Uninstall.log"  

Pause 

Repair the Product 

"\\SmartPlant P&ID\Setup Files\Setup.exe" -repair -silent -log 

"C:\Repair.log" 

Pause 

Modify Product Features 

"\\SmartPlant P&ID\Setup Files\Setup.exe" /modify /silent /log 

"C:\Update Features.log" ADDLOCAL="OPTIONSMGR" REMOVE="RULEMGR" 

Pause 
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SmartPlant Reference Data for P&ID contains the symbols, rules, labels, styles, templates, 
insulation specification and other information that you use to create a P&ID. The default location 
for the reference data is ..\SmartPlant\P&ID Reference Data. 

If the reference data is located elsewhere, use SmartPlant P&ID Options Manager to identify the 
location of symbols, rules, labels, and other reference data for the application. You can also 
define symbology for graphics, default formats for data, and key distances that affect the 
behavior of the application. Usually, a project manager sets these options at the beginning of a 
project. The project manager seldom modifies these options except on rare occasions when 
project requirements dictate a change. For more information, see Customizing Your Reference 
Data (on page 73). 

 

 If you are upgrading from a previous version of the software, you may also need to upgrade 
your reference data. For details, see Upgrading Reference Data (on page 57). 

 You do not need to set the default data locations in Options Manager before creating a P&ID 
in SmartPlant Drawing Manager. These locations are set at the time of plant structure 
creation. The drawing template path should be set to the correct node name and share 
name so that the software can locate the templates for P&ID creation. For the correct share 
name, see Install SmartPlant P&ID Reference Data (on page 33). 

 For a configuration in an integrated environment, be sure the SmartPlant Resource Path 
setting in Options Manager points to the SmartPlant Resources folder installed with the 
SmartPlant P&ID reference data. 

 

Install SmartPlant P&ID Reference Data 
1. Insert the SmartPlant P&ID DVD into the drive. If the installation does not start 

automatically, double-click setup.exe in the main folder. 

2. On the Welcome page, click the Additional Software link. 

3. On the Additional Software page, click SmartPlant P&ID Reference Data. 

4. On the SmartPlant P&ID Reference Data Setup Wizard Welcome page, click Start Setup to 
start the reference data setup wizard. 

5. On the Details and Features page, under Select Features to Install, make sure that the 
SmartPlant Electrical Reference Data check box is selected. 

6. In the Install Path field, accept the default installation path or if desired, specify a different 
path, and then click Next. 

7. On the License Agreement page, select your country or region from the list to view the 
license agreement in your language and then select the I agree to the license agreement 
and conditions check box. 

Configuring Reference Data for 
SmartPlant P&ID 
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8. Click Install. 

9. On completion of the installation, if you want to open the Readme file, select View Readme. 

10. Click Finish to close the installation wizard. 

11. After installation, do the following: 

a. Share the folder that contains the reference data.  All SmartPlant users must be granted 
read permission to this share.  Write permission to the share is required to make 
changes to the symbols, rules, templates, and other reference data. 

b. Ensure that the SmartPlant Resource Path setting in Options Manager points to this 
folder. 

 We recommend that you make a copy of the reference data and store it with your 
plant files.  This common practice will help you with future service pack installations, data 
recovery, and so forth. 
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You can use SmartPlant P&ID in thin client mode, which supports Citrix.  When working in an 
integrated environment, thin client mode operation is used as the means of providing 
Workshare. 

 

 When you access the SmartPlant P&ID application via Citrix, we strongly recommend that 
you do not perform any administration activities that run automatically for a long time on a 
client machine.  When you execute administration activities via Citrix client, the software 
actually performs these activities on the server side, while the client remains idle, and the 
connection to Citrix is lost, possibly resulting in corruption of data.  Examples of these types 
of administration activities are: upgrading the database to a new version or importing a large 
number of drawings. 
As a workaround, we recommend that you perform these kinds of activities either on your 
database server machine or on a client machine using a configuration other than Citrix. 

 When using thin client mode, all users share a common database, resulting in intellectual 
property being shared between all sites. 

 In a Citrix environment, links within a .chm file to open a web browser will not work. To 
view the linked web page, copy and paste the web address into the web browser on your local 
machine. 

 
 

Comparison of Thin Client Mode and SmartPlant P&ID 
Workshare 

For data sharing between sites, you can use SmartPlant P&ID's Workshare functionality or you 
can run SmartPlant P&ID in thin client mode using Citrix XenApp. 

Using SmartPlant P&ID Workshare 

Users on the host and on each satellite work in separate databases.  This means that it is 
possible to segregate intellectual property between sites by transferring only the data that needs 
to be shared.  When using Workshare, it is necessary to update reference data at remote 
locations and to move data between sites. 

Using Thin Client Mode 

All users share a common database, so that there is no need to update reference data at remote 
locations or to move data between sites. 

Working in Thin Client Mode 
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Tuning the Software for Use in Thin Client Mode 
The following procedures describe special instructions for the installation of SmartPlant P&ID 
when working in thin client mode on a Citrix machine.  Tuning SmartPlant P&ID involves 
performing the following operations: 

 Installing SmartPlant P&ID on Citrix. 

 Creating Global Objects. 

 Publishing the SmartPlant P&ID program to enable it to be viewed on a web page or in a 
published Citrix application list. 

 
 

Create Global Objects 
In order to run SmartPlant P&ID via Citrix using Oracle, users or groups that will be using 
SmartPlant P&ID are required to be included in the "Create Global Objects" policy security 
setting. 

1. In Windows, open Control Panel. 

2. Click Administrative Tools. 

3. Double-click the Local Security Policy icon. 

4. In the left pane of the window that opens, expand the hierarchy Local Policies > User 
Rights Assignment. 

5. In the right pane, double-click Create global objects. 

6. On the Create global objects Properties dialog box, click Add User or Group. 

7. On the dialog box that opens, add the users or groups that will be using SmartPlant P&ID. 
 

Publish SmartPlant Applications Using XenApp 6.5 
You need to publish the application to allow you to view the data using a web page. 

 You must perform this procedure for each executable file for which you want to 
view data; for example, the SmartPlant P&ID program (SmartPlantPID.exe), Drawing Manager 
(DrawingManagerEXE.exe), Options Manager (Options Manager.exe), Rule Manager (Rule 
Manager.exe), and so forth. 

 The SmartPlant P&ID program and SmartPlant P&ID Engineering cannot co-exist on the 
same machine, therefore they cannot both be published on the same Citrix server. 

1. Click Start > All Programs > Administrative Tools > Citrix > Management Consoles > 
Citrix AppCenter. 
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2. Under your farm, click Applications. 

 

3. Click Action > Publish application. 

 

4. On the Publish Application wizard Welcome page, click Next. 

5. On the Name page, enter values for Display name and Application description, and then 
click Next. 
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6. On the Type page, choose the application type options as follows: 

a. Select the Application option button (the default). 

b. Under Application type, click Accessed from a server. 

c. From the Server application type list, select Installed application. 
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d. Click Next. 

7. On the Location page, under Command line, click Browse and navigate to the executable 
(.exe) file for the application being published, and then click Next. 
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8. On the Servers page, do the following: 

a. Click Add. 

b. On the Select Servers dialog box, select Servers. 

c. Select the Include subfolders check box. 
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d. Click Add All. 

 

e. Click OK to return to the wizard Servers page. 
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f. Click Next. 

9. On the Users page, add a domain user account that is to be granted access to the 
published application as follows: 

a. Click Add. 

b. On the Select Users or Groups dialog box, click Add List of Names. 

c. Enter names using the format user@domain. 

d. Click Check Names to verify the entered names. 
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e. Click OK on the Account Names Checked verification message box. 

 

f. Click OK on the Add List of Names dialog box. 

g. Click OK on the Select Users or Groups dialog box to return to the wizard Users page. 
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h. Click Next. 

10. On the Shortcut presentation page, do the following: 

a. Click Change Icon to change the application icon if necessary. 

b. Select options for application shortcut placement as desired. 
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c. Click Next. 

11. On the Publish immediately page, click Finish. 
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If successful, the application will appear under Applications. 

12. Repeat the above steps for each application you want to publish. 
 

Publish SmartPlant Applications Using XenDesktop 
7.0 RDS 

You need to publish the application to allow you to view the data using a web page. 

 You must perform this procedure for each executable file for which you want to 
view data; for example, the SmartPlant P&ID program (SmartPlantPID.exe), Drawing Manager 
(DrawingManagerEXE.exe), Options Manager (Options Manager.exe), Rule Manager (Rule 
Manager.exe), and so forth. 

 The SmartPlant P&ID program and SmartPlant P&ID Engineering cannot co-exist on the 
same machine, therefore they cannot both be published on the same Citrix server. 

1. Click Start > All Programs > Citrix > Citrix Studio. 

2. In the left pane, click Delivery Groups and do one of the following: 
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 In the main window, click the Delivery Groups tab, select the groups, and in the 
Actions pane at the right, click Create Application. 

 In the main window, click the Applications tab and in the Actions pane at the right, 
click Add Applications. 

 

3. On the Introduction wizard page, click Next. 
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4. On the Applications page, select the check boxes beside the applications you want to add 
and click Next. 
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 If you want to add an application from a location other than the local machine, click 
Add applications manually and in the dialog box that opens, enter the required 
information. 
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5. On the Summary page, click Finish. 

 

If successful, the application will appear under Applications. 

6. Repeat the above steps for each application you want to publish. 
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S E C T I O N  9  

Most of the upgrade procedures are performed using the SmartPlant Engineering Manager 
Upgrade Utility. This section deals with details of the procedures that apply to SmartPlant P&ID 
only. For full details of the upgrade process, including actions required for SmartPlant P&ID, 
refer to the SmartPlant Engineering Manager Installation and Upgrade Guide, under the section 
Upgrading the Database. 

 SmartPlant P&ID versions 2014 and later are compatible with Oracle 11g; 
therefore, if you have an older version of Oracle, you must upgrade it before upgrading 
SmartPlant P&ID. 

Upgrade Prerequisites 

1. Identify Oracle database constraint violations using the Database Constraint Report.exe 
delivered with the current version of SmartPlant P&ID. If you are working on a SQL Server 
platform, you can skip this step. 

2. If your site database is out of date, upgrade it using SmartPlant Engineering Manager, and 
then if the application database is out of date, upgrade it using the SmartPlant Engineering 
Manager Upgrade Utility. If you are using Workshare and have a satellite plant, upgrade that 
plant too. 

3. Open and then close SmartPlant P&ID Options Manager without running any commands. 
This action updates the RAD version for the ProjectStyles.spp file and as a result, changes 
the status of the Symbology for the drawings to 'Out-of-Date'. 

4. Update drawings as needed using SmartPlant P&ID Drawing Manager. 
 

Correcting Database Constraint Violations for 
SmartPlant P&ID 

The Database Constraint Report.exe reporting utility delivered with your current version of 
SmartPlant P&ID is used to help you identify whether the SmartPlant P&ID data stored in your 
Oracle database is compliant with the database constraints. You must run this utility before you 
begin upgrading SmartPlant P&ID. 

 If you are working on a Microsoft SQL Server platform, you do not need to check for 
database constraint violations. 

Tasks for correcting constraint violations 

1. Make a complete backup of the data you are upgrading. 

2. Generate a Database Constraint Exceptions Report. For more information, see Generate a 
Database Constraint Exceptions Report (on page 52). 

3. Clean up the database by removing orphan model items. For more information, see Clean 
Data Utility (DelOrpModItems.dll) in the SmartPlant P&ID Utilities Guide. 
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4. Resolve constraint violations. For more information, see Using Constraint Utilities (on page 
53). 

5. Generate a database constraint exceptions report again. 

6. Run the appropriate constraint utilities again if any exceptions still exist. 

7. Continue running the database constraint report and the constraint utilities until no 
exceptions are reported. 

8. Make a complete backup of the now compliant data. 

 For additional information on resolving discrepancies listed in the database constraint 
report, contact your Customer Service representative. 
 

Generate a Database Constraint Exceptions Report 

Use SmartPlant P&ID or one of its manager applications to connect to the plant on which you 
want to run the Database Constraint Exception Report utility. 

 

 If you use SmartPlant P&ID to connect to the plant, be sure to close all drawings before 
proceeding. 

 Microsoft Excel must be installed on any workstation from which you run the Database 
Constraint Exception Report utility. 

1. In the ..\SmartPlant\P&ID Workstation\bin folder, double-click the Database Constraint 
Report.exe file. 

2. On the Database Constraint Exception Report Utility dialog box, click Connect to Active 
Plant. 

 The utility runs the report on the active plant that you are connected to at the 
time. To run a report on another plant, connect to that plant using SmartPlant P&ID or one of 
its manager applications. 

3. After connecting to the database, click the Create Database Constraint Report button. 
This process may take several minutes, depending on the amount of data you have in your 
plant. 

4. When complete, the utility automatically saves a copy of the report in the temp directory 
under your user profile and displays the file name (plant name - 
ConstraintExceptions.xls) in the list box on the right side of the Database Constraint 
Exception Report Utility dialog box. 

5. Exit the Database Constraint Exception Report utility. 

6. Open the report using Microsoft Excel and save a copy of the report to another location 
other than the Temp folder. 

7. Review the completed report for discrepancies that must be resolved before you can 
upgrade to the new version of SmartPlant P&ID. We recommend running this utility again 
until no discrepancies are reported. 
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Database Constraint Report Results 

The Database Constraint Report file is a Microsoft Excel file containing several worksheets. 

The first sheet in the report is the Report Progress Messages, which contains a list of the 
constraint checks made and the number of violations detected for each constraint check. Each 
violation type appears on its own worksheet, with the name of the constraint violation displayed 
on the worksheet tab. 

Each worksheet also contains a list of drawings containing constraint exceptions, along with the 
name of the recommended constraint utility (usually in cell B1) to use in resolving the violation. 

 All constraint utilities, including the Clean Data utility (DelOrphModItem.dll), are run on an 
open drawing inside SmartPlant P&ID. However, unlike all the other constraint utilities that run 
on a drawing-by-drawing basis, the Clean Data utility runs on the entire plant data set. If Clean 
Data is used to resolve any particular constraint violation, a particular drawing will not be 
specified in the report for this constraint violation nor will a utility name be listed at the top of the 
worksheet. 
 

Using Constraint Utilities 

Before running any of the constraint utilities recommended by the database constraint report, 
run the Clean Data utility inside a blank drawing, then run the Database Constraint Report.exe 
again. Running Clean Data first decreases the number of exceptions listed in the report and 
lessens the amount of further manual data cleanup required. For more information about 
running the Clean Data utility, see Clean Data (Delete Orphan Model Items) in the SmartPlant 
P&ID Utilities Guide. 

The remaining constraint utilities must be run from within specific drawings. These utilities are 
located in the ..\SmartPlant\P&ID Workstation\bin folder, along with the Clean Data 
(DelOrphModItems.dll) utility. 

Each plant may require a different set of utilities. Open each drawing listed in the database 
constraint report and run the recommended macros on the drawing. You need to run only the 
macros listed in the report for that particular drawing. 
 

Constraint Utilities 

Delivered with SmartPlant P&ID, the following constraint utilities help you correct any database 
constraint exceptions reported in the database constraint exception report. 

In general, each utility attempts to repair the constrain violation.  However, in some cases the 
violation cannot be cleaned up by the utility and the item is band-aided in the drawing.  This 
situation is noted and logged in each utility's corresponding log file.  For more information, see 
Constraint Utilities Log Files (on page 55). 

 You must manually fix any band-aided item in a drawing by deleting the item and 
replacing it.  If you have difficulty finding the band-aided items, click Tools > Options in 
SmartPlant P&ID, then select the Display as Printed option on the Options > General tab. 

cmdnotconnectedcomps.dll — Repairs items that have a relationship to a PipeRun or 
SignalRun (sp_piperunid or sp_signalrunid are not null), but are not referenced by a 
corresponding connector.  If the relationship cannot be repaired, you must delete it and replace 
it. 
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cmdLPCheck.dll — Checks for LabelPersist records pointing to a representation that does not 
exist.  If the graphical label is watching a graphic, the database is updated to match, thus 
repairing the LabelPersist.  If the label cannot be repaired, the utility band aids it.  You should 
delete and replace these band-aided items. 

cmdRepOIDCheck.dll — Checks for symbol records with a null graphic OID.  If the graphical 
symbol exists, the utility repairs the item by updating the database with its graphic OID value.  If 
the graphical symbol does not exist, the utility sets the InStockpile flag = True to repair the item. 

ConnectorItem12.dll — Checks for connector records pointing to a symbol that does not 
exist.  If the graphical connector is connected to a symbol, the utility repairs the connector by 
updating the database to match.  If the connector cannot be repaired, the utility band aids 
it.  You should delete and replace these band-aided items. 

OPCFK.dll — Checks for OPC records with a partner that does not exist.  If the graphical OPC 
exists, fix it.  You should delete these items. 

PointIndexCheck.dll — Checks for PipingPoint records and SignalPoint records with non-
unique indices or point numbers, then repairs the item by deleting from the database whichever 
one of the duplicate points is not loaded into the cache. 

RelationshipOIDMacro.dll — Checks for relationship records with a null graphic OID.  If the 
graphical relationship indicator exists, the utility repairs the item by updating the database with 
its graphic OID value.  If the graphical relationship indicator does not exist, the utility deletes the 
relationship from the database. 

RepairBadConnector.dll — Checks for connectors with the same start and end objects and 
connectors with the wrong number of vertices.  The utility band aids the graphical connector, 
which you should delete. 

RepairNullFileNameCmd.dll — Checks for LabelPersist records with a null file name value. 

 If the number of LabelPersist records equals the number of SmartLabel objects locked to the 
watched symbol, the utility repairs the LabelPersist record by updating the filename value for 
the LabelPersist. 

 If the number of LabelPersist records does not equal the number of SmartLabel objects 
locked to the watched symbol, then the utility band aids the watched symbol.  You should 
delete band-aided items. 

 For the remaining LabelPersist records with a null filename, if the graphic exists, the utility 
band aids it. You should delete band-aided items.  If the graphic does not exist, the utility 
deletes the representation from the database. 

RepairOrphanedNozzleCmd.dll — Checks for the following situations. 

 Nozzle records without a Parent — If the Nozzle graphic is not in the drawing, the utility 
repairs the nozzle by setting the Instockpile flag = True. If the Nozzle graphic is in the 
drawing, the utility tries to set either the SP_EquipmentID or SP_PartOfID based on the 
graphic relationship.  The graphic parent must be an equipment or equipment component 
for the relationship to be re-established.  If the relationship cannot be re-established, the 
utility band aids it.  You should delete band-aided items. 

 Nozzles associated via SP_EquipmentID to a Parent in the stockpile — If the Nozzle 
graphic is not in the drawing, the utility repairs the Nozzle by setting the Instockpile flag = 
True.  If the Nozzle graphic is in the drawing, the utility band aids it.  You should delete 
band-aided items. 
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 Nozzles associated via SP_PartOfID to a Parent in the stockpile — If the Nozzle graphic 
is not in the drawing, the utility repairs the Nozzle by setting Instockpile flag = True. If the 
Nozzle graphic is in the drawing, the utility band aids it.  You should delete band-aided 
items. 

 Nozzles that are a Part of a Run — The utility clears the SP_PartOfID attribute.  If the 
Nozzle graphic is not in the drawing, the utility repairs the Nozzle by setting the Instockpile 
flag = True.  If the Nozzle graphic is in the drawing, the utility band aids it.  You should 
delete band-aided items. 

 

Constraint Utilities Log Files 

Each constraint utility generates a log file, which records each action taken to correct the 
constraint violation. 

 Log files are located at the path specified in your TEMP environment variable. 

Constraint Utility Log File 

cmdnotconnectedcomps.dll RepairNotConnectedComps.log 

cmdLPCheck.dll RepairBadEmbLabelCmd.log 

cmdRepOIDCheck.dll RepresentationOIDChecks.log 

ConnectorItem12.dll ConnectorItem12_Check.log 

DelOrpModItems.dll (CleanDB) SPDelOrpModItems.log 

DBCleanup.txt 

OPCFK.dll OPC_OPC_FK.log 

PointIndexCheck.dll PointIndexConstraint_check.log 

RelationshipOIDMacro.dll RelationshipOID_Checks.log 

RepairBadConnector.dll RepairBadConnector.log 

RepairOrphanedNozzleCmd.dll RepairOrphanedNozzles_.pid.log 

RepairNullFileNameCmd.dll RepairNullFileNameCmd.log 
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Post-Upgrade Tasks 
After you complete all of the upgrade tasks for a plant, make a full backup of the upgraded 
databases. You should also use the Oracle analyzer scripts to optimize your databases. 

Some or all of the following post-upgrade tasks may also be required: 

 Backup Each Upgraded Plant (on page 56) 

 Use Oracle Analyzer Scripts (on page 56) 

 Preserve Software Customizations (on page 56) 

 Update Symbology Definitions (on page 57) 

 Make Additional Changes for SmartPlant P&ID (on page 57) 
 

Backup Each Upgraded Plant 

After you have completed the upgrade process for each plant, you should do the following: 

1. Set the backup location for the plant in SmartPlant Engineering Manager and perform a full 
backup. For more information about backing up a plant, see the Backup and Restore section 
of the SmartPlant Engineering Manager Help. 

2. Perform a complete database backup. 

3. Perform a file system backup to archive the drawings, reference data, and other files. 
 

Use Oracle Analyzer Scripts 

The Oracle performance tuning documentation recommends analyzing the database objects 
after a large number of records have been added.  These analyzer scripts collect statistics and 
store them internally in the database to determine potential execution paths so that the one with 
the lowest cost can be selected for use.  After the upgrade, you should add these scripts to 
your nightly backup routine. 
 

Preserve Software Customizations 

The Upgrade Utility does not make changes that might overwrite user customization of display 
names, property formats, calculation programs, validation programs, or layouts. 

 A data dictionary change made during an upgrade can cause layouts that use 
PipingPoint properties to have an incorrect caption or column heading.  None of the default 
layouts delivered during installation include PipingPoint properties.  However, if you added 
these properties to one of the default layouts or created a new layout with PipingPoint 
properties, you can manually revise the captions for any layouts that use PipingPoint properties 
after you upgrade by doing the following: 

1. Open SmartPlant P&ID. 

2. In the list on the Engineering Data Editor toolbar, select the saved view that contains 
PipingPoint properties. 

3. In the Engineering Data Editor, click the View  menu and select Edit View. 

4. On the Table Properties dialog box, click Advanced. 



 Upgrading SmartPlant P&ID 

 

 

SmartPlant P&ID Installation and Upgrade Guide 57 
 

5. Click the Layout tab. 

6. In the Display Property list, select the PipingPoint property. 

 PipingPoint properties start with the word End, such as End, End 2, End 3, and End 4. 

7. Confirm that the caption is appropriate for the property. 

8. If you need to modify the caption, make changes in the Caption box at the bottom of the 
Advanced Table Properties dialog box. 

 

Update Symbology Definitions 

In an upgraded plant, the new Ducting Symbology options appear at the bottom of the list and 
are assigned default color, width, and line pattern properties. The following procedure ensures 
that the new item types will receive the correct symbology properties. 

1. Click Start > Programs > SmartPlant P&ID > Options Manager. 

2. Select the site and plant for which you want to update the symbology definitions. 

3. Move the symbology definitions of the 3 ducting nozzle entries above the general nozzle 
symbology definitions. 

4. Assign color, width, and line pattern properties as desired to all new ducting and room 
symbology definitions. 

 

Make Additional Changes for SmartPlant P&ID 

After running the Upgrade Utility, you must still perform the following changes manually for the 
current version of SmartPlant P&ID: 

 Open and save the rules file so that the new rule options are added to the Rules.rul file. 

 Copy any new or modified symbols from ..\SmartPlant\P&ID Reference Data to the plant's 
reference data, making sure that you do not overwrite any customizations. 

 

Upgrading Reference Data 
Reference data often changes between versions of the software.  These changes can include 
deletions and additions to reference data, as well as modifications to existing data formats and 
locations.  After you upgrade your plant data using the SmartPlant Engineering Upgrade Utility, 
you can use the Upgrade Reference Data command in SmartPlant P&ID Options Manager to 
upgrade styles, template files, symbols, and assemblies. 

User Access 

Before you can upgrade the reference data and drawings for an upgraded plant, you must 
define user access for the plant in SmartPlant Engineering Manager.  For more information 
about defining user access, see the SmartPlant Engineering Manager User's Guide. 

 

 After you upgrade reference data, you cannot view it in earlier versions of the software. 

 For information about changes made during the reference data upgrade, see the 
V4RefDataUpgrade.log file. This log file is saved in the folder where the symbols are 
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stored. For more information about upgrading reference data, see the SmartPlant P&ID 
Options Manager User's Guide. 

 

Upgrade Reference Data 

1. Click Start > Programs > SmartPlant P&ID > Options Manager. 

2. Select the site and plant for which you want to upgrade reference data. 

3. Click Tools > Upgrade Reference Data.  A splash screen displays, then a message box 
informs you when the upgrade operation successfully completes. 

 

4. Click OK. 

 

 After you upgrade reference data, you should not view it in earlier versions of the software. 

 For information about changes made during the reference data upgrade, see the 
V4RefDataUpgrade.log file.  This log file is saved in the folder where the symbols are 
stored. 

 For more information about upgrading reference data, see SmartPlant P&ID Options 
Manager Help. 

 

Updating Drawings 
Changes are often made to the SmartPlant P&ID reference data while work is being managed 
on the P&IDs. When these changes are made, they apply to all drawings items after the time of 
change, but do not apply to existing drawing items. The Update Drawings functionality (provided 
by the set of Out-of-Date Drawings commands in Drawing Manager) allows you to manage 
which drawings are updated with the latest reference data changes by defining values that 
define out-of-date drawings criteria and by resolving any symbols that have been deleted, 
moved, or renamed. 

You can also schedule these update operations and create reports. For more information about 
this functionality, see the Drawing Manager User's Guide. 
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 Using the Update Drawings functionality is not required as part of the upgrade process, but it 
is strongly recommended. 

 After upgrading to the latest version of SmartPlant P&ID, opening Options Manager for the 
first time updates the RAD version for the ProjectStyles.spp file and as a result, changes the 
status of the Symbology for the drawings to 'Out-of-Date'.  For this reason, after upgrading 
SmartPlant P&ID, you should open and close Options Manager once before updating your 
drawings using SmartPlant P&ID Drawing Manager. 

 After upgrading SmartPlant P&ID from a version earlier than 2014, you should open and 
close Rule Manager once before updating your drawings using SmartPlant P&ID Drawing 
Manager. This ensures that the Rules.rul file is updated with the new rules. The following 
rules were added in SmartPlant P&ID 2014: 

 Connect To Process To Duct Run 

 Duct Run 

 Duct Run Label 

 Duct Run OPC To Duct Run 

 Duct Run To Duct Run 

 Duct Run To Nozzle 

 Ducting Components 

 Ducting Component Label 

 Ducting Comp To Duct Run 

 Ducting Comp To Ducting Comp 

 Ducting Comp To Instrument Inline 

 Ducting Comp To Nozzle 

 Ducting Comp To Signal Pipe Run 

 Instrument Inline To Duct Run 

 Internal Nozzle To Room 

 Nozzle To Room 

 Process Pipe Run to Ducting Comp 

 Room 

 Room Component 

 Room Component Label 

 Room Comp to Room 

 Room Comp to Room Comp 

 Room Label 

If an existing rule has the same name as one of the new rules, a numeric suffix is added to 
the name of the new rule, for example: 'Duct Run_1' 
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When you submit a selection of P&IDs to the Out-of-Date Drawings > Update command, 
Drawing Manager analyzes the drawing for changes to the following: 

 Data Dictionary (select lists) 

 Formats 

 Symbols (moved and missing symbols, and changes to the .sym file) 

 Rules Manager 

 Options Manager (heat tracing, gapping, and symbology) 

 Model Items (via Llama) 

 OPCs (moved) 

 Drawings in a Re-create state 

 Drawing Properties 

After this analysis process, a summary displays, listing the number of drawings selected, the 
number of out-of-date drawings, and the number of drawings with missing symbols. You must 
manually resolve the missing symbols using the Resolve Missing Symbols dialog box, which 
lists the symbols in question and allows you to define the new location of each symbol. 

In addition to the interactive approach of updating drawings, you can schedule the entire update 
process, except for the resolution of missing symbols, which is a manual process as described 
above. 

Reporting capability provides a summary of the selected drawings and the out-of-date criteria 
detected during the analyze step. This report format is non-configurable. 
 

Update Command 

Displays the Update Drawings dialog box.  When you select this command, the selected 
drawings are analyzed based on the out-of-date criteria and the results display on the Update 
Drawings dialog box. 

 

 Update does not update any symbol whose definition has been changed into a break 
component. This situation occurs when you have a catalog item that has been placed in a 
drawing and then you change its definition to be a break component. The SmartPlant P&ID 
Replace command does not allow a non-breaking component to be replaced with a break 
component. The Update command relies on the SmartPlant P&ID Replace command to 
replace symbols that are out-of-date. 

 If an item type property has Write P&ID or Write Both permissions in Data Dictionary 
Manager and a symbol belonging to the item type is changed in Catalog Manager, running 
the Update command on a drawing in Drawing Manager will NOT overwrite values assigned 
to this property with any defaults that may have been pre-defined in Catalog Manager. If the 
property permissions are Write Catalog in Data Dictionary Manager, Update will restore any 
default property values defined in Catalog Manager. 
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 Intergraph recommends that you backup your work or create a version of your work 
prior to using this command. 

 

Total drawings selected — Displays the number of drawings selected. 

Report — Generates a Microsoft Excel report describing the details of out-of-date drawing(s). 

Out-of-date drawings — Displays the number of drawings that are out-of-date based on the 
criteria selected using the Out-of-Date Drawing Criteria dialog box. 

Resolve — Displays the Resolve Missing Symbols dialog box.  Use this button to resolve any 
missing symbols. 

Drawings with missing symbols — Displays the number of out-of-date drawings containing 
symbols that do not exist in the catalog. 

  If the path to your Rules file is set incorrectly in SmartPlant P&ID Options Manager, then 
the Update Drawings command will not work.  For example, if the path is invalid, then all 
drawings in the project are in an out-of-date state but the software cannot update them.  This 
error also occurs if the Catalog Explorer Root Path specified in SmartPlant P&ID Options 
Manager is invalid.  An error message displays and the report displays Drawings with a ? in 
the criteria column have missing or incorrect reference data.  
 

Resolve Command (File > Out-of-Date Drawings > Update 
Drawings Menu) 

Displays the Resolve Missing Symbols dialog box which provides a way for you to define any 
symbols that have been deleted, moved, or renamed. 

 

 In order to resolve any missing symbols, you must have an existing symbol in the catalog to 
define as the replacement for the missing symbol. 

 You cannot resolve missing symbols for offline instruments of a different class using this 
command. 
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Old Path - Displays the relative path of the missing symbol. 

New Path - Displays possible options for defining correct locations for the missing symbol(s). 

Drawings - Displays the list of drawings that contain the missing symbol(s). 

 

See Also 
Update Command (on page 60) 
 

Out-of-Date Drawing Criteria Command (Tools Menu) 

Displays the Out-of-Date Drawing Criteria dialog box, from which you can define the criteria 
used to search for out-of-date values when you use the File > Out-of-Date Drawings 
commands. 
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Out-of-Date Drawing Criteria Dialog Box 

Allows you to define the criteria used to search for out-of-date values when you use the File > 
Out-of-Date Drawings commands. 

 

Select out-of-date drawing criteria 

Select List Changes 

 Data Dictionary Select List GUID on the drawing item is not equivalent to select list GUID in 
Data Dictionary. 

 PID Select List GUID on the drawing item is not equivalent to the select list GUID in PID 
schema. 

Format Changes 

 Formats GUID on the drawing item is not equivalent to Formats GUID from the Database. 

 Default Formats GUID on the drawing item is not equivalent to Default Formats GUID in 
Option Manager setting. 

Out-of-Date Symbols — File Last Modified Time Stamp on at least one representation in the 
drawing is not equivalent to the File Last Modified Time Stamp on the corresponding symbol 
definition file. 

Missing Symbols — Filename specified for at least one representation in the drawing does not 
have the corresponding symbol definition file available in the current catalog. 

Rule Changes — Rules GUID on the drawing item is not equivalent to the GUID from the Rules 
file. 

Heat Trace Changes — Heat Trace GUID on the drawing is not equivalent to the Heat Trace 
GUID in Option Manager Setting. 

Gapping Changes — Gapping GUID on the drawing item is not equivalent to the Gapping 
GUID in Option Manager Setting. 
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Symbology Changes — Symbology GUID on the drawing item is not equivalent to the 
Symbology GUID in Option Manager Setting. 

Out-of-Date Model Items — SP_ModelItemTimeStamp for at least one representation in the 
drawing is not equivalent to the TimeStamp on the History Item of its Model Item.  This criteria 
covers model items updated via Llama (Outside the drawing). 

Moved OPCs — MatingOPCPath (will have Drawing ID of its mate) on the OPC is not 
equivalent to the SP_DrawingId of its mate OPC.  The OPC label is in a to-be-updated state as 
its mate has been moved. 

Recreate State — The drawing is in a re-create state. 

Drawing Property Changes — Property Changes GUID on the drawing item is not equivalent 
to Drawing Property Changes GUID on the drawing item. Drawing Property Changes GUID is 
set when drawing properties are modified from Drawing Manager. 

 



 

 

SmartPlant P&ID Installation and Upgrade Guide 65 
 

S E C T I O N  1 0  

User access identifies the users allowed to work at specified access levels within the site and 
related plant structures.  With user access, administrators can control access to data and 
thereby ensure the security of their project data. 

 

 To see the roles currently defined for a plant, click the Roles node under the plant node in 
the Tree view. 

 To view the rights settings for a particular role, right-click the role in the List view and click 
Properties. 

Mutually-Exclusive Rights 

User rights can vary from one plant to another in the same site.  These rights are defined by 
categories.  Categories with radio button options indicate that the rights contained within are 
mutually exclusive, meaning you can choose only one right in that category to apply to the role.  
In other categories, you can choose multiple rights, as denoted by check boxes. 

 None — The user is not allowed to execute the application or utility for this plant structure. 

 Read-Only — The user can execute the application or utility for this plant structure to view 
the data held within it. 

 Modify Settings — The user can execute the application or utility for this plant structure to 
view the data held within it and to modify any custom settings. 

 Full Control — The user can execute the application or utility for this plant structure and 
perform all commands and modifications.  This right is not available to a satellite site when 
operating in the Workshare mode because the reference data must be controlled by the host 
site. 

 
 

SmartPlant P&ID User Rights 

Category Options Description 

Catalog None None prevents users from accessing Catalog 
Manager. 

 Read-Only Read-Only allows users to view symbols in Catalog 
Manager, but not make changes. 

 Full Control Full Control allows users to create new symbols 
and edit existing symbols.  Full Control is disabled 
for Workshare satellites and projects. 

User Access 
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Category Options Description 

Plant Filters None None prevents users from accessing Filter Manager. 

 Read-Only Read-Only allows users to view existing filter 
definitions, but not make changes. 

 Full Control Full Control allows users to create new filters and 
edit existing filters.  Full Control is disabled for 
Workshare satellites and projects. 

Display Sets None 

Read-Only 

Full Control 

Controls the ability to view, edit, and define display 
sets.  Full Control is disabled for Workshare 
satellites. 

Default Views None 

Read-Only 

Full Control 

Controls the ability to specify default filters and 
layouts for item types.  Also controls setting the 
Brief/Bulk Lists associated with item types.  
Full Control is disabled for Workshare satellites and 
projects. 

Plant Reports None None prevents users from accessing the plant 
reports. 

 Read-Only Read-Only allows users to view existing report 
definitions, but not make changes. 

 Full Control Full Control allows users to create new plant 
reports and edit existing reports.  Full Control is 
disabled for Workshare satellites and projects. 

Rules None None prevents users from accessing Rule Manager. 

 Read-Only Read-Only allows users to view existing rule 
definitions, but not make changes. 

 Full Control Full Control allows users to create new rules and 
edit existing rule definitions.  Full Control is 
disabled for Workshare satellites and projects. 
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Category Options Description 

Data Dictionary None None prevents users from accessing Data Dictionary 
Manager.  Modify Select Entry and Full Control 
are disabled for Workshare satellites and for 
projects. 

 Read-Only Read-Only allows users to view settings in the data 
dictionary, but not make any changes. 

 Modify Select 
Entry 

Modify Select Entry allows users to edit select lists. 

 Full Control Full Control allows users to add items and edit 
existing items in the data dictionary.  Modify Select 
Entry and Full Control are disabled for Workshare 
satellites and for projects. 

Options None None prevents users from accessing Options 
Manager. 

 Read-Only Read-Only allows users to view option settings, but 
not make any changes. 

 Modify Settings Modify Settings allows users to change reference 
data pointers. 

 Full Control Full Control allows users to add options and edit 
existing options.  Full Control is disabled for 
Workshare satellites and for projects, but users must 
have at least Modify Settings level privileges to use 
Workshare. 

Insulation 
Specifications 

None None prevents users from accessing Insulation 
Specification Manager. 

 Read-Only Read-Only allows users to view insulation settings, 
but not make any changes. 

 Full Control Full Control, disabled for Workshare satellites and 
projects, allows users to add settings and edit 
existing insulation settings. 
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Category Options Description 

Drawing Management Create P&ID Create P&ID allows users to execute the New 
Drawing command in Drawing Manager. 

 Delete P&ID Delete P&ID allows users to execute the Delete 
command in Drawing Manager. 

 Refresh P&ID Refresh P&ID allows users to execute the Compare 
and Refresh and Validate commands in SmartPlant 
P&ID.  Users must also have Full Control permission 
for P&ID Objects before they can refresh a drawing. 

 Create Version Create Version allows users to execute the Create 
Version command in Drawing Manager. 

 Delete Version Delete Version allows users to execute the Delete 
Version command in Drawing Manager. 

 Fetch Version Fetch Version allows users to execute the Fetch 
Version command in Drawing Manager. 

 Edit Import Map Edit Import Map allows users to execute the Edit 
Import Map command in Drawing Manager. 

 Update P&ID Update P&ID allows users to execute the Update 
P&ID command in Drawing Manager to update 
existing drawings. 

 Create Revision Create Revision allows the user to create revision 
properties, modify revision properties, and associate 
revision properties with the revised drawing. 

 Delete Revision Delete Revision allows the user to delete a revision 
and its associated version. 

P&ID Objects None None prevents users from accessing objects in the 
SmartPlant P&ID Modeler environment. 

 Read-Only Read-Only allows users to view objects in the 
SmartPlant P&ID Modeler environment, but not 
make any changes. 

 Modify Properties To import, user needs at least the Modify 
Properties right. 

 Full Control To refresh drawings in SmartPlant P&ID, users must 
have Full Control permission on P&ID Objects. 
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Category Options Description 

Workshare Publish Publish allows users to publish drawings to other 
satellites or back to the host. 

 Get Latest 
Version 

Get Latest Version allows users to obtain the latest 
published drawing from the host or satellite site. 

 Assign Drawing 
Ownership 

Assign Drawing Ownership allows users to specify 
which Workshare sites have read/write permission 
for published drawings. 

 Synchronize 
Reference Data 

Synchronize Reference Data allows users to 
update their reference data with the reference data 
at the host. 

 Synchronize 
Shared Items 

Synchronize Shared Items allows users to update 
their shared items with the shared items at the host. 

Projects Check Out Check Out allows users to execute the Check Out 
and Undo Check Out commands in Drawing 
Manager. 

 Check In Check In allows users to execute the Check In 
command in Drawing Manager. 

 Fetch Fetch allows users to execute the Fetch command 
in Drawing Manager. 

 Change Status Change Status allows users to interact with the 
Project Status dialog box in Drawing Manager.  If 
you are not granted this right, you can only view the 
project status, but cannot modify it. 

 Claim Claim allows users to execute the Claim and 
Release Claim commands in SmartPlant P&ID. 

SmartPlant Publish 

Retrieve 

Enables or disables the ability to publish to or 
retrieve documents.  Select the check box to enable 
an option; clear to disable. 
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SmartPlant P&ID User Rights Examples 

The following examples are suggestions for granting rights to common groups of users.  These 
examples are a great starting place for defining custom SmartPlant P&ID role templates. 

Plant Administrators 

This user group has full control over all aspects of the plant structure for drawings, 
administrative tasks, and reference data.  The users should have the capability to create plant 
groups, add applications and roles, create projects, enable Workshare, and create satellites, but 
should not see the hierarchy templates or plant group types. 

Plant Users 

This group has full control on all drawings, can set personal filters, set up personal display sets, 
set up My Reports, create drawings, and archive drawings (needed for personal use in case 
there are big changes to the drawing design). 

Engineers 

This group has access to drawings to view and modify data reports but not graphics. They can 
set up personal filters, set up personal display sets, and create My Reports. They should not be 
able to modify any project reference data or perform any administrative tasks with respect to 
drawing management, projects, or Workshare activities. 

Managers 

This group needs only view data access. They can set up personal filters, set up personal 
display sets, and create My Reports. They should not be able to modify any project reference 
data or perform any administrative tasks with respect to drawing management or Workshare 
activities. 

Category Administrators Users Engineers Managers 

SPEM Plant Structure 
Access 

Full Control Read-Only Read-Only Read-Only 

Catalog Full Control None None None 

Plant Filters Full Control Read-Only Read-Only Read-Only 

Display Sets Full Control Full Control Full Control Full Control 

Default Views Full Control Read-Only Read-Only None 

Formats Full Control None None None 

Plant Reports Full Control Read-Only Read-Only None 

Rules Full Control None None None 
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Category Administrators Users Engineers Managers 

Data Dictionary Full Control None None None 

Options Full Control None None None 

Insulation 
Specifications 

Full Control None None None 

Drawing Management Create P&ID, 
Delete P&ID 

Create P&ID Undefined (do 
not choose 
anything) 

Undefined (do 
not choose 
anything) 

P&ID Objects Full Control Full Control Modify 
Properties 

Read-Only 

Workshare Publish, Get 
Latest Version, 
Assign Drawing 
Ownership,  
Synchronize 
Reference 
Data, 
Synchronize 
Shared Items 

Undefined (do 
not choose 
anything) 

Undefined (do 
not choose 
anything) 

Undefined (do 
not choose 
anything) 

SmartPlant Publish, 
Retrieve 

Undefined (do 
not choose 
anything) 

Undefined (do 
not choose 
anything) 

Undefined (do 
not choose 
anything) 
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Several tools are delivered during installation that allow you to customize your reference data. 
 

Customize Reference Data Options 
Reference data options control the look and feel of the product and controls much of the data 
used throughout the life of a project. 

Use SmartPlant P&ID Options Manager to define how you want particular P&ID items to appear 
in drawings by selecting colors, line styles, gapping styles, and heat tracing styles for the 
project. 

1. Click Start > Programs > SmartPlant P&ID > Options Manager. 

2. Define the symbology, gapping, heat tracing, formatting, and distances as needed. 

3. Click Settings. 

4. Verify that all \\node\share entries are set to the shares defined during reference data 
installation. 

5. Click File > Save. 

For more information about working with reference data options, see the SmartPlant P&ID 
Options Manager User's Guide. 
 

Establishing Design Rules 
By defining typical or standard design rules, you can quickly and easily place required 
equipment, interconnecting piping, instrumentation, and other accessories on a drawing.  These 
rules define the placement characteristics of items and how items interact with each 
other.  Using rules, you also confirm that you meet proper design criteria. 

The Rule Manager provides the tools for creating and editing rules.  For more information, see 
the SmartPlant P&ID Rule Manager User's Guide. 
 

Working with Filters 
SmartPlant Filter Manager, delivered with SmartPlant Engineering Manager, allows you to select 
the items to display in the engineering application. You can use this feature to clear the view of 
other items to display one class of items. 

For more information about working with filters, see the SmartPlant Filter Manager User's Guide. 

Customizing Your Reference Data 
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Working with Formats 
SmartPlant Format Manager, delivered with SmartPlant Engineering Manager, allows you to 
define the characteristics and formats for labels, report data and formatted properties. You can 
also create and edit formats. 

For more information about working with formats, see the SmartPlant Format Manager User's 
Guide. 
 

Working with Symbols and Labels 
Symbols include a graphic representation of the item as well as the properties associated with 
that item. SmartPlant Catalog Manager, delivered with SmartPlant Engineering Manager, allows 
you to create and edit these symbols. 

Some of the characteristics of a SmartPlant symbol include the graphic representation of the 
item, labels, heat tracing, the icon that represents the item in the Catalog Explorer, and the 
properties associated with the item. 

Two types of labels display important information about drawing items: 

 Driving — Sets the property in the model, for example, a dimension that changes the size of 
the object. 

 Driven — Reports the property in the model, for example, a pressure label that takes its 
pressure value from the associated pump. 

 For more information about working with symbols and labels, see the SmartPlant Catalog 
Manager User's Guide. 

 
 

Modifying Data Model Properties 
SmartPlant Data Dictionary Manager, delivered with SmartPlant Engineering Manager, allows 
you to modify the data model properties, including the database entries, select lists, and item 
types that form the underlying data structure. 

With Data Dictionary Manager, you can perform the following tasks: 

 Add and change properties for specific database tables 

 Create select lists and add entries to them 

 Associate validation programs with various item types 

Because your changes can affect the database for the entire project, only system administrators 
and project managers typically customize the database with Data Dictionary Manager. 

For more information about using Data Dictionary Manager, see the SmartPlant Data Dictionary 
Manager User's Guide. 
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Configuring Border Templates 
The delivered borders are embedded in the delivered template files. Before you can see 
modifications made to the drawing border during the course of a project, you must edit the 
delivered templates. If you do not modify the delivered template files, the borders of the 
drawings created with these templates will not be modifiable on a global level. In other words, 
changes to border files do not show up in drawings that are using the embedded border 
template files, which means that you can change the border of drawings only on a drawing-by-
drawing basis. 
 

SmartPlant P&ID Delivered Templates 

SmartPlant P&ID delivers the following border templates. 

Metric Templates 

Template File Border File Page Size 

A0-Size.pid A0border.igr A0 Wide (1189mm x 841mm) 

A1-Size.pid A1border.igr A1 Wide (841mm x 594mm) 

A1-Wide(Metric).pid A1-Wide(Metric).igr A1 Wide (841mm x 594mm) 

A1-Wide Note Area.pid A1-Wide Note Area.igr A1 Wide (841mm x 594mm) 

A2-Size.pid A2border.igr A2 Wide (594mm x 420mm) 

A2-Wide(Metric).pid A2-Wide(Metric).igr A2 Wide (594mm x 420mm) 

A2-Wide Note Area.pid A2-Wide Note Area.igr A2 Wide (594mm x 420mm) 

A3-Size.pid A3border.igr A3 Wide (420mm x 297mm) 

A3-Wide (Metric).pid A3-Wide (Metric).igr A3 Wide (420mm x 297mm) 

A4-Size.pid A4border.igr A4 Wide (297mm x 210mm) 

A4-Wide (Metric).pid A4-Wide (Metric).igr A4 Wide (297mm x 210mm) 

A5-Size.pid A5border.igr A5 Wide (210mm x 148mm) 
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English Templates 

Template File Border File Page Size 

A-Size.pid A-Wide.igr A Wide (11in x 8.5in) 

A-Wide (Imperial).pid A-Wide (Imperial).igr A Wide (11in x 8.5in) 

B-Size.pid B-Wide.igr B Wide (17in x 11in) 

B-Wide (Imperial).pid B-Wide (Imperial).igr B Wide (17in x 11in) 

C-Size.pid C-Wide.igr C Wide (22in x 17in) 

C-Wide (Imperial).pid C-Wide (Imperial).igr C Wide (22in x 17in) 

C-Wide Note Area 
(Imperial).pid 

C-Wide Note Area 
(Imperial).igr 

C Wide (22in x 17in) 

D-Size.pid D-Wide.igr D Wide (34in x 22in) 

D-Wide (Imperial).pid D-Wide (Imperial).igr D Wide (34in x 22in) 

D-Wide Note Area 
(Imperial).pid 

D-Wide Note Area 
(Imperial).igr 

D Wide (34in x 22in) 

E-Size.pid E-Wide.igr E Wide (44in x 34in) 

 
 

Edit Delivered Templates 

Before editing the delivered templates, verify that the correct plant structure has been selected 
and that no drawings are open. 

1. In Windows Explorer, browse to the default templates location defined in Options Manager 
or the location of the reference data of your plant. 

2. Select the template that matches the system of units and page size requirements for the 
drawing and double-click the template file to open it in SmartPlant P&ID.  Refer to the 
previous chart to determine the appropriate template and border files. 

 You also can drag the template file into the application window to open the template 
file. 

3. Select the existing border file, and press Delete. 

4. Click Edit > Insert > Object. 

5. Clear the Link check box to be sure the item will be embedded. 

6. Click Browse. 

7. Click the border file to use. You can use the delivered border or choose another border. 
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8. Click Open. 

9. Click OK on the Insert Object dialog box. 

10. Position the border file in the template. 

11. Click File > Exit. 
 

Create a Border Template 

1. Start SmartPlant P&ID. 

2. Verify that the correct plant structure has been selected. 

3. Click File > New Template. 

4. Click File > Page Setup. 

5. Select the sheet size in the Standard option and then click OK. 

6. Click File > Properties. 

7. On the Units tab select a unit in the Length, Angle, and/or Area Readout boxes to specify 
the default units of measure, and then click OK. 

8. Click Edit > Insert > Object. 

9. Verify that Link is selected if you want the border file linked, or clear the Link check box if 
you want to embed the file. 

10. Select the border to use and click Open, and then click OK. 

11. Click File > Save. 

12. Type the name for the template in the File Name box. 

13. Save the template border in the default templates location defined in Options Manager. 

14. Click Save. 

15. Click File > Exit. 
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Integration standardizes and improves the communication among the various authoring tools 
you use in the course of designing, constructing, and operating a plant.  SmartPlant integration 
manages data exchange among these authoring tools, which enables sharing and re-use of 
plant information throughout the plant life-cycle.  SmartPlant Foundation acts as a repository for 
data and a medium through which information is shared among other tools, such as Aspen 
Basic Engineering, SmartPlant Instrumentation, SmartPlant Electrical, and Smart 3D. 

Most of the commands that provide access to SmartPlant integration functionality exist in the 
common user interface available on the SmartPlant menu in Engineering Manager, SmartPlant 
Instrumentation, SmartPlant Electrical, SmartPlant P&ID, and Drawing Manager. 

The following graphic displays what SmartPlant P&ID publishes and retrieves and shows the 
flow of data and the different types of data. 

 

SmartPlant P&ID interacts with SmartPlant Foundation by correlating items between the plant 
database and the SmartPlant Foundation database, retrieving documents from SmartPlant 
Foundation. Also, SmartPlant P&ID creates a set of tasks in the To Do List that you can run to 
update the plant database. In SmartPlant P&ID, you can also use the commands on the 

Working with SmartPlant Integration 
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SmartPlant menu to publish documents and retrieve data, access the SmartPlant Foundation 
Web Portal in order to browse in SmartPlant Foundation, and subscribe to change notifications 
and compare documents. 

 You can only use the SmartPlant menu commands after your plant is registered.  For 
more information, see SmartPlant Engineering Manager Online Help. 

Registering Tools 

Before you can publish and retrieve documents from any of the other authoring tools, such as 
SmartPlant Electrical or SmartPlant Instrumentation, you must register each plant in SmartPlant 
P&ID with a SmartPlant Foundation database.  The connection allows SmartPlant P&ID to use 
the commands on the SmartPlant menu.  A SmartPlant Engineering Manager administrator 
typically registers a plant. 

The software maps a plant and all its projects to a single SmartPlant Foundation URL, which 
points to one, and only one, SmartPlant Foundation plant database and its projects.  When you 
use the Register command in any of the authoring tools, you are registering an authoring tool 
plant with a SmartPlant Foundation URL and plant that you specify. 

The system administrator must register each plant in the authoring tool once; this action takes 
place in SmartPlant Engineering Manager.  After the plant is registered, you can publish and 
retrieve documents. 
 

Preparing the Integrated Environment 
To enable SmartPlant P&ID to work in an integrated environment, you must do the following: 

1. Install the Schema Component and the SmartPlant Client, delivered with SmartPlant 
Foundation, on each SmartPlant Engineering Manager and SmartPlant P&ID 
workstation.  For more information about installing these components, see the SmartPlant 
Enterprise Installation and Setup Guide. 

 Before you install the Schema Component and the SmartPlant Client, be sure to 
install the software prerequisites described in the SmartPlant Client Workstations section of 
the SmartPlant Enterprise Installation and Setup Guide. 

2. Use a hierarchy that contains a minimum of three levels when you create your plant in 
SmartPlant Engineering Manager. 

 In addition to requiring a minimum of three-levels in hierarchies, SmartPlant 
configurations also require that the names of hierarchy items cannot be changed after they 
are created and that the hierarchy structure cannot be modified after you create the 
project.  For more information, see the SmartPlant Enterprise Installation and Setup Guide 
or the Using Custom Hierarchies in an Integrated Environment (on page 85) topic in 
SmartPlant Engineering Manager Help. 

3. Associate applications with and assign user access rights to your plant. 

 When SmartPlant P&ID and SmartPlant Electrical are both enabled for a plant, they 
are both enabled for all projects in that plant.  If a project requires only one of these 
applications, create separate plants for each application, then enable SmartPlant P&ID for 
one plant and SmartPlant Electrical for the other. 

4. Edit the SmartPlant Resource Path setting in Options Manager to point to the SmartPlant 
Resources folder installed with the SmartPlant P&ID reference data. 
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 The path specified in Options Manager must contain the tool schema (for 
example, SPIDDataMap.xml) for publish and retrieve operations between the tool and 
SmartPlant to work properly.  For more information, see the SmartPlant P&ID User's Guide. 

5. Register your SmartPlant plant with SmartPlant Foundation, as described in the SmartPlant 
Engineering Manager Help. 

 

 When you register your plant, you must specify the location of the SmartPlant 
Engineering Manager schema map file (SPEMDataMap.xml).  For more information, 
see the Specify Map File Dialog Box topic in SmartPlant Engineering Manager Help. 

 If only one application is associated with the plant at the time it is registered, only that 
application is registered.  If another application is later associated with the plant, the 
Register command is enabled so that you can register the new application with the 
plant. 

 

Tool Requirements for Integrating SmartPlant P&ID 
This topic describes rules and settings that allow SmartPlant P&ID data to be shared correctly 
with Aspen Basic Engineering, Smart 3D, SmartPlant Instrumentation, and the other tools that 
are part of an integrated environment.  Other tools that are not listed here have no known 
SmartPlant P&ID/SmartPlant integration issues. 

General Integration Requirements 

The following is a list of best practice scenarios for using SmartPlant P&ID so that data will 
migrate correctly to other SmartPlant tools: 

To enable publishing from a project, you must create a project in SmartPlant Foundation 
with the same name (case-sensitive) as the P&ID project. 

 When creating formats for use with SmartPlant P&ID publishing, the formats must be added 
and mapped in SPPIDDataMap.xml using Schema Editor. The UID string of the custom 
SPMapUOMDef map file must be of the form SPMU_<NN>_FormatName>, where 'NN' 
represents the SPMapUOMListDef ID for the format type (for example Temperature = 5; 
Pressure = 27). Since spaces or restricted characters are not allowed in the UID string, 
custom format names must not include spaces or restricted characters. 

 If you intend to publish select lists (enum lists) to SmartPlant Foundation, make sure that 
you review the SmartPlant Adapter for SmartPlant P&ID Guide to understand the 
requirements (see under Data Transformation Logic > Publish/Retrieve). 

 If the SmartPlant P&ID item tag validation allows for duplicate tags, this may have an impact 
on downstream tools such as SmartPlant Instrumentation, which does not allow duplicates. 
In such cases, allowing duplicates in SmartPlant P&ID can cause problems in the retrieving 
tool. 

 By default, SmartPlant P&ID item tag validation does not allow duplicate item tags for 
loops or instruments. 
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Integration with SmartPlant Instrumentation 

Retrieving Documents 

 If a SmartPlant P&ID drawing that includes items with a flow direction is to be retrieved by 
SmartPlant Instrumentation, a flow direction of End 1 Upstream or End 1 Downstream 
must be defined in SmartPlant P&ID. Bi-directional flow is not supported. 

Connect to Process Lines 

 Connect to Process lines are required for connecting instruments to equipment nozzles 
and pipe runs in SmartPlant P&ID. 

 All non-piped offline equipment instruments must be connected to vessels through non-
electric signal lines and nozzles in SmartPlant P&ID.  This enables SmartPlant 
Instrumentation to recognize that instruments are connected to vessels. 

 If SmartPlant P&ID assigns an object to an intermediate level in the hierarchy and publishes, 
SmartPlant Instrumentation will assign the object to the level in the hierarchy in SmartPlant 
Instrumentation determined by their logic.  Because instruments belong to units in 
SmartPlant Instrumentation, an instrument assigned to the intermediate level in SmartPlant 
P&ID will be assigned to the unit in SmartPlant Instrumentation. Panels will be assigned to 
the plant. SmartPlant P&ID may get an update on retrieve to move the object to another 
level in their hierarchy than where it was published based on the move done automatically 
by SmartPlant Instrumentation. Panels will move to the top level; instruments will move to 
the bottom. 

Instrument Expansion 

 A SmartPlant P&ID instrument or loop tag does not always have a 1:1 relationship with 
instruments in SmartPlant Instrumentation.  In some cases, a single item tag in a P&ID 
corresponding to an instrument or loop needs to be expanded to create several instruments 
when publishing the data for SmartPlant Instrumentation.  For this purpose, the Expansion 
Type property in SmartPlant P&ID specifies the expansion behavior when publishing an 
instrument or loop.  Each value of the property corresponds to a SmartPlant Instrumentation 
rule that determines which instrument types and numbers are to be created in SmartPlant 
Instrumentation when the SmartPlant P&ID tag is expanded and retrieved. 

 When retrieving data back to SmartPlant P&ID, the behavior of a particular 
instrument created by expansion is determined by SmartPlant Instrumentation parameters.  
For an expanded instrument, the state of the IRetrievableExpansion interface determines 
whether that instrument will be retrieved by SmartPlant P&ID: if the IRetrievableExpansion 
interface is realized, the instrument is retrieved, whereas if the IRetrievableExpansion 
interface is not realized, the instrument is not retrieved.  The 'parent' item tag is always 
retrieved, regardless of the realization state of the IRetrievableExpansion interface. 

Ports 

 SmartPlant Instrumentation uses physical ports, while SmartPlant P&ID uses logical ports.  
SmartPlant Instrumentation publishes the physical ports with the Dimensional Data Sheets 
and not the Instrument Index.  SmartPlant P&ID retrieves the Instrument Index and does 
not retrieve the Dimensional Data Sheets. 
When the workflow goes from SmartPlant P&ID to SmartPlant Instrumentation, followed by 
SmartPlant Instrumentation publishing the Dimensional Datasheet, a Same As relationship 
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is created between the ports in the SmartPlant Foundation database.  That Same As 
relationship is required by Smart 3D to correctly match the design basis ports to the 3D 
representation of the ports. 
When the workflow goes from SmartPlant Instrumentation to SmartPlant P&ID, however, a 
Same As relationship is not created in the SmartPlant Foundation database. Without the 
Same As relationship created in the SmartPlant Foundation database, the result may be 
additional ports in Smart 3D.  To obtain the Same As relationship on the ports requires that 
SmartPlant P&ID publish the P&ID with the instrument, this P&ID be retrieved by SmartPlant 
Instrumentation and then having SmartPlant Instrumentation publish the Dimensional Data 
Sheet. 

Integration with Smart 3D 

General 

 In Options Manager, ensure that under Settings, the Use Piping Specification setting 
value is Smart 3D even if the P&ID plant is not validating piping specifications. This is to 
ensure that the required Piping Component Select List entries are properly set to match the 
PIP short codes expected by Smart 3D.  For details, see Configure Piping Specification 
Settings in SmartPlant P&ID Options Manager User's Guide. 

Drawing Items 

 For Smart 3D to properly determine flow direction in a process run, that process run must be 
connected to at least 2 items. 

 Some items that can be represented as single objects in SmartPlant P&ID, such as Vent 
Detail, are modeled in Smart 3D as a set of separate objects.  For full correlation to be 
established between the two tools, ensure that these objects are modeled in SmartPlant 
P&ID with the same configuration used to represent them in Smart 3D. 

Properties 

 Smart 3D handles temperature and pressure properties in pairs and does not support having 
a temperature (for example, Normal Operating Temperature) without defining the matching 
pressure (in this case, Normal Operating Pressure). While this is a valid condition for 
SmartPlant P&ID, it should be a consideration when publishing for retrieval into Smart 3D.  
Without the Pressure / Temperature pair of values defined, the Smart 3D user will be 
required to enter a value that was not defined in SmartPlant P&ID. 

Integration with Aspen Basic Engineering 

Retrieving Documents 

 Basic Engineering data sheets can contain multiple objects and may be formatted in a 
traditional data sheet view or list view (for example, as an equipment list).  Data sheets 
retrieved from Basic Engineering may include stream data, specialty piping data, or relief 
valve data as required by business practices. 
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Using Workshare in an Integrated Environment 

The following rules apply to using the Workshare functionality within an integrated SmartPlant 
environment: 

 You can enable and disable Workshare before or after registering a Greenfield plant. 

 You can create satellites and connect to them after registering. 

 You cannot register a satellite. 

 You cannot retrieve a WBS document when Workshare is enabled. 

Using the Integration Commands Within a Workshare Collaboration 

The Workshare host can perform the following actions from within SmartPlant P&ID when 
registered. For more information about these commands, see the SmartPlant P&ID User's 
Guide. 

 Publish — Any drawing can be published. 

 Retrieve — Any SmartPlant document can be retrieved. 

 Correlate — Reviewing correlation is available if the drawing is in a read-only state.  It is not 
possible to assign correlation in a read- only drawing. 

 To Do List — Only available at the Workshare Host.  To Do List tasks may be reviewed on 
drawings for which the host does not have ownership, but these tasks may not be executed 
unless ownership is assigned to the Host.  The To Do List is not available at the Satellite. 

Using the Catalog Index in SmartPlant P&ID and SmartPlant 
Integration 

When you select the Retrieve command, the software accesses the CatalogIndex.mdb and the 
system performs the following actions: 

1. Using the retrieved document, the object type and classification of the retrieved item is 
determined. 

2. Using the SmartPlant P&ID Map file, the ItemTypeName (Equipment, PipeRun, 
PipingComp, Loops, and so forth), and codelist indices for Class, Sub-Class, and Type is 
determined. 

Catalog Index Lookup 

The Catalog Index file is used to find a symbol in the catalog with type properties that match the 
given values.  The lookup is performed using the most specific information first. If a match is 
found, that symbol is used. However, if there is no match, the more generic type information is 
used for additional searches. In this way, a generic symbol will be returned if no specific symbol 
is available in the catalog. 

Search Based on Type Value — Searches the catalog index for all rows with matching 
ItemTypeName and Type values and IsDefaultForType = True.  If one or more rows are found, 
the software uses the CatalogItemName from the first one.  If no match is found, the software 
performs the search based on Subclass. 

Search Based on Subclass Value — Searches the catalog index for all rows with matching 
ItemTypeName and SubClass values and IsDefaultForSubclass = true.  If one or more rows are 
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found, the software uses the CatalogItemName from the first one.  If no match is found, the 
software performs the search based on Class. 

Search Based on Class Value — Searches the catalog index for all rows with matching 
ItemTypeName and Class values and IsDefaultForClass = True.  If one or more rows are found, 
the software uses the CatalogItemName from the first one.  If no match is found, the software 
returns an empty string. 
 

Mapping for SmartPlant Integration 
If you customize the plant database items or attributes in your SmartPlant Engineering Manager 
plant, you must define the mapping between these customized plant attributes and the 
properties in the SmartPlant schema. 

1. Open the plant data dictionary by right-clicking the plant in the Tree view in SmartPlant 
Engineering Manager and selecting the Data Dictionary Manager command.  For more 
information, see Data Dictionary Manager Command (Tools Menu). 

2. Add or modify the attributes in Data Dictionary Manager for each level in your hierarchy.  
For more information, see the Add a Property to Database Tables topic in the Data 
Dictionary Manager User's Guide. 

3. Open the plant SPEMDataMap.xml schema map file in the Schema Editor and map the 
plant database items between the tool schema (SPEMDataMap.xml) and the SmartPlant 
schema.  For more information, see the Schema Editor User's Guide. 

 

 If you add an enumerated list attribute to the plant data dictionary, see the Hierarchical 
Enumerated Lists topic in the SmartPlant P&ID User's Guide for information about mapping 
these complex data types. 

 The default SPEMdatamap.xml file contains the EF_SPAPlant attributes (CompanyName, 
SiteName, SiteLocation, DivisionName, and DivisionLocation).  This file is delivered to the 
..\Engineering Manager\SmartPlant Resources folder. 

 
 
 

Using Custom Hierarchies in an Integrated 
Environment 

SmartPlant integration supports custom hierarchies, as long as they contain a minimum of three 
levels. By default, the delivered SPEMdatamap.xml file is compatible with the standard 
SmartPlant Plant > Area > Unit hierarchy. 

 

 After registering, SmartPlant Engineering Manager cannot retrieve the PBS document if the 
plant and SmartPlant hierarchies are not compatible. To be compatible with the SmartPlant 
hierarchy, your plant hierarchy can contain less than or equal, but not more than the number 
of levels in the SmartPlant hierarchy. 
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 SmartPlant Engineering Manager retrieves from the SmartPlant hierarchy only the hierarchy 
levels it needs. For example, if your plant hierarchy contains 4 levels and the SmartPlant 
hierarchy contains 8 levels, only the top 4 levels of the SmartPlant hierarchy are retrieved. 

 All SmartPlant Engineering Manager hierarchy item names (plant group names) below the 
plant (top level) must match the names in the SmartPlant Foundation plant hierarchy that are 
at the same level. The names are case-sensitive and therefore the cases must also 
match. The plant names do not have to match. 

 In addition to requiring a minimum of three-levels in hierarchies, SmartPlant integration also 
requires that the names of hierarchy items cannot be changed after they are created and 
that the hierarchy structure cannot be modified after you create the project. For more 
information, see the SmartPlant Enterprise Installation and Setup Guide. 

 

Register Command (SmartPlant Menu) 
Allows you to register a plant database, along with its associated applications, with an instance 
of SmartPlant Foundation.  Each database must be registered before you can connect to 
SmartPlant Foundation to perform any specific tasks, such as publishing or retrieving files.  You 
can register each plant database only once. 

During registration, the software maps the plant database, all of its projects, and all of its 
associated applications to a single SmartPlant Foundation URL, which points to one SmartPlant 
Foundation plant database, and returns a unique signature for the tool/plant combination being 
registered. 

 

 You must install the Schema Component and the SmartPlant Client, delivered with 
SmartPlant Foundation, on your SmartPlant Engineering Manager workstation before you 
can register your plant. 

 If only one application is associated with the plant at the time it is registered, only that 
application is registered.  If another application is later associated with the plant, you must 
also register the new application with the plant. 

After the plant is registered, the SmartPlant tab is added to the Plant Structure Properties 
dialog box.  The SmartPlant tab displays the SmartPlant Foundation URL, the SmartPlant 
Foundation plant database, and the unique application identifiers returned by the registration 
process. 
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